Handbook for
Merlin Project
4
© 2018 - ProjectWizards GmbH

Contents - as of June 2018
Introduction

1

About this document

1

Conventions used

1

Demo Mode (30-Day Trial)

1

The main window

2

Toolbar

3

Work Area

19

Inspector

19

Details

20

Menu bar

21

Merlin Project

21

File

40

Edit

81

Format

91

Insert

93

Structure

97

View

102

Window

108

Help

120

Inspectors

121

Inspector »Project Settings«

121

Inspector »Activity«

131

Inspector »Dependency«

150

Inspector »Resource«

153

Inspector »Assignment«

164

Inspector »File«

178

Inspector »Checklist«

183

Inspector »Event«

188

Inspector »Information«

194

Inspector »Issue«

199

Inspector »Risk«

204

Inspector »Styles«

210

Inspector »Time scale«

221

Inspector »View Options«

223

Inspector »Column«

228

Columns

237

Add a column

238

Custom Columns

238

Column Sets

239

Custom Column Sets

240

Filter Function

242

Creating Filters

242

Editing Filter Conditions

242

Enable/Disable Filters

245

Keyboard shortcuts

247

Tips & Tricks

253

Mouse & Keyboard

253

Keyboard

256

Using the Mouse

258

Appendix
Acknowledgements

261
261

Introduction
Merlin Project is a project management software solution for the Mac. This is the
accompanying guide for version 4.

About this document
This help document is your Merlin Project user reference. It explains how the main view of
Merlin Project is organized and where you can find the program’s key sections. It
describes the available functions based on the program’s extensive menus and contains a
detailed introduction to all the various objects’ Inspectors. You will also find here
information about available columns, keyboard shortcuts or tips & tricks.
The help document is provided as a single file to bring together many advantages for you:
• Using the Web browser’s search function, which you access as usual by pressing
cmd+F, you can search for content across the file.
• You can print the documentation to serve as a reference guide.

Conventions used
This help document has been written so you can understand it as easily as possible and
apply it in practice when using Merlin Project. All sections are organized by topic and
feature screenshots. Key text passages are highlighted using special markings. These are
easily identifiable using the symbols described in the following and refer to additional
information as well as key hints and tips.





Note: Notes contain additional explanations.
Tip: Tips contain additional information on a topic.
Important: Contains important information.

Demo Mode (30-Day Trial)
After downloading and installing Merlin Project you can try it free of charge in Demo Mode.
When starting Merlin Project, you will see the notification shown.
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Click "Start 30-Day Trial" to start the free-of-charge 30-day demo version. You can use
the full functionality of the product during this period.
Click "Use without license" to use the product without a license. This only lets you use the
product to read files; you cannot use it to edit content.
Click "Buy Now" to purchase a license for the product. You will be forwarded automatically
to the online shop.



In the top right-hand corner of the program window, you will see a
notification if using the product on a 30-day trial. This tells you how
many days remain of the trial period.

Once the trial period has ended, the following notification will appear in the top right-hand
corner of the program window.

Click it and the notification window shown will be displayed.

Click "Buy now" and you will be forwarded automatically to the online shop where you can
purchase a license for the product.
Click "Manage licenses" and the licenses preferences will open automatically.

The main window
The Merlin Project main window is divided into the following sections:
• Toolbar(1)
• Work Area(2)
• Inspector(3)
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The main window

• Details (hidden by default)

If required, you can adjust the size and divisions of the main window by dragging the
separators using your mouse. When you hover over the separators, the mouse pointer will
change accordingly. If you don’t have enough screen space, sections can be hidden.



You can find the hidden separators between the individual sections in
the main window. The mouse pointer will turn into a double-headed
arrow when you hover over them. This lets you move and adjust the
sections in the directions shown.

Toolbar
The toolbar contains favorite icons for frequently used options in Merlin Project. You can
use these options on selected project content and the main window by clicking them.
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Toolbar Icons
Here is a list of the default symbols in Merlin Project.
On the left you will find icons for editing project content:
• New (+)
• Indentation
• Link
• Action

On the right you can find icons for frequently used options for working with projects:
• Critical Path
• Library
• Sync
• Work Area
• Resources
• Settings
• Details
• Inspector

Customize Toolbar
You can customize the toolbar content, add further icons, and display it differently using
the »View > Customize Toolbar« menu.
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Toolbar

If the Customize Toolbar option is activated, you can use your mouse to arrange and
remove toolbar icons. You can also drag other icons from the window onto the toolbar.



You can restore the default icons to the toolbar using the default set.

The toolbar can be hidden or made visible again under the »View > Hide/Show Toolbar«
option.

The toolbar has been hidden

New (+)
The »+« icon represents the »New« option. This lets you create new content in the
project. Click it to create a new project activity.



The new content is always created below the current selection. If you
have not selected anything in the project window, the new content will
be created directly below the last line right at the end of the project.

If you click the arrow icon to the right of the »+« icon, a context menu will appear with a
list of all content available.
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Indentation
The »Indentation« icon is split into two parts. Depending on the selection, it can have one
or two functions. When indenting, activities in the outline are either indented one level
lower (to a group or subgroup) or one level higher (from a group/subgroup).

Indenting to another level creates a sub-activity and also creates a resulting group
automatically. The activity above the indentation automatically becomes a group.



You can indent multiple selected activities. Additionally, you can use
your mouse to nest activities in other activities or indent/outdent
activities in the levels using the »Structure > Indent« or »Structure >
Outdent« menu, or the corresponding keyboard shortcuts »ctrl + cmd +
>« or »ctrl + cmd + <«.

Outdent
When objects have been indented, the Outdent option becomes active on the »Indent«
icon. This lets you further indent or outdent the selected activities.

It is easy to identify project content that has indented or outdented in the outline as it is
also shown graphically as being shifted to the left or right.
It is easy to indent or outdent selections using the keyboard shortcuts »ctrl + cmd + >« or
»ctrl + cmd + <«.
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Toolbar

Link
The »Link« icon creates dependencies between activities, groups, and milestones. You
need to select at least two or more activities to create a link.

By default, a Finish to Start link is created when you click the icon.

If you click on the arrow icon to the right, a context menu will appear with other links you
can choose from.

Action
The »Action« icon contains options you can use on your selection.
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These include frequently used functions which you can also find on the menu bar and, to
some degree, in the icons discussed:
• Insert
• Assignments
• Cut
• Copy
• Insert
• Delete
• Freeze Sorting
• Link
• Save Selection …
• Separate Group…

Library
The »Library« icon opens and closes the »Library« window. This lets you manage and
store assorted project information and content as well as use it again for later projects.
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Press F3 to show or hide the Library quickly.

Toolbar

The Library is a separate window which manages content across the project. You will find
a search box on the upper edge of the window. This lets you find content quickly. Below
this you will find a list of content including:
• Attachments
• Documents
• Contacts
• Outlook contacts
• Activities
If you click one of these folders, further divisions appear on the right-hand side of the list.
Below this is the Content list which is populated with content from the category you
selected.
Use your mouse to drag content from and to the library. If you "drag & drop" content to the
library, it will appear under one of the mentioned points.



The Contacts and Outlook contacts folders are populated automatically
with addresses using content from the programs »Contacts« and
»Outlook«.

You will find the gear icon on the lower edge of the window. Click it and a context menu
will appear containing further options for using the Library. The gear icon is context
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sensitive which means different options are displayed depending on your selection.

Among other options, you can use the gear icon to create new folders in the Library for the
particular categories and access Library settings. Additionally, you can open selected
documents directly using a compatible program.
Attachments
The Attachments folder contains:
• All Items
• Own Items
• Standard Attachments
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Toolbar

The All Items folder lists all attachments in the Library.
The Own Items folder contains attachments defined by the user.
The Standard Attachments folder includes the attachments built into Merlin Project.
Documents
The Documents folder contains three folders for storing and using documents belonging
or useful to the project.
• All Items
• Own Items
• V-Modell XT
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The All Items folder lists all documents in the Library.
The Own Items folder contains documents added by the user. These can be of any file
type.
The V-Model XT folder includes »V-Model XT« documents.



The V-model is used to regulate the software development process
within the German federal administration. It encompasses the
procedure, methods to be applied, and functional requirements for tools
to be applied. [Source: Wikipedia.com]

Contacts
The Contacts folder contains content from the Contacts.app. This gives you direct access
in the Library to your addresses in the Contacts.app and lets you use them to create
assignments/resources.
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Toolbar



If you drag an address book entry from the Contacts list to an object in
Merlin, this entry will be created as an assignment/resource in the
current project.

You can activate/deactivate the address books under the tab of the same name under
»Preferences > Library«. Additionally, you can also add LDAP Directory Services there.

Outlook contacts
The Outlook contacts folder contains address book entries from the Outlook.app (part of
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Microsoft Office). This gives you direct access in the Library to your addresses in the
Outlook.app and lets you use them to create assignments/resources.



If you drag an address book entry from the Outlook contacts list to an
object in Merlin, this entry will be created as an assignment/resource in
the current project.

You can activate/deactivate the address books under the tab of the same name under
»Preferences > Library«. Additionally, you can also add LDAP Directory Services there.
Activities
The Activities folder contains two folders by default containing activity and group
templates. This lets you build modular projects comprising various
phases/groups/activities. You can use your mouse to drag and drop such activities to and
from the Library.
• All Items
• Own Items
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Toolbar

The All Items folder contains all activities/groups.
The Own Items folder contains activities/groups stored by the user in the Library.
The Activities folder lets you store frequently used content for various projects in the
Library and allows you to integrate it at a later date and when required into one or more
projects.

Drag the »Project start« from the Library to the outline of a new project. The content will
then be adopted automatically in the new project.
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Resources
The »Resources« icon contains a pop-up window letting you add resources to the project
by clicking the »+« icon on the left. Use the arrow icon on the right to show the Resources
View in the work area.



Press F4 to hide and show Resources quickly.

The »Resources« icon is ideal for providing you with a quick overview of resources already
used in the project and for creating new resources.



You can free the window from the icon and view it as a separate window.
Among other things, this is especially advantageous when working with
multiple projects. The window always contains the resources used in the
current project.

To create a separate »Resources« window, hover the mouse pointer over the triangle
pointing to the icon and then click and drag the window down to free it.
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Toolbar

You can close the window at any time and access it as a pop-up by clicking the
»Resources« icon.
Settings
The »Settings« icon shows the Inspector with the Project Settings for the open project.

Details
The »Details« icon shows an extra section in the project window. The Details section
contains the Attachments view by default. It lets you view and edit all attachment types in
a project.



Press F2 to show or hide the Details view quickly.
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In the additional Details section you can select further views. It makes displaying, editing,
and sharing a project in different styles easy. The work area (above) and details area
(below) can therefore contain different views.

Inspector
The »Inspector« icon shows or hides the Inspector. This frees up more space for the work
area. If required, click the »Inspector« icon to show the Inspector. Press F1 to show or
hide the Inspector quickly.
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The Inspector can be displayed in a separate window. This option can be
found under Preferences under the »General« tab. The Inspector
position option lets you integrate the Inspector into the main window or
use it in its own separate window.

Toolbar

Work Area
You can view and edit project content using various views in the work area. Work
Breakdown > »Activities« is the default view. The Activities view is divided into an outline
view on the left and a Gantt chart or bar chart on the right.
The outline contains the project content structure and you can add various columns to it.
The Gantt chart or bar chart contains the visual representation of the objects listed in the
outline (Activities, Milestones, Groups and Assignments).
The work area will change depending on the selected view.

In the work area you can view, edit and share your project in any graphical manner.
The »Details« icon will show an extra section in the project window. The Details section
contains the Attachments view by default. It offers you to view and edit all attachment
types in a project.
In Details you can select further views. It makes displaying, editing and sharing a project in
different styles easy. Work area (above) and details area (below) can therefore contain
different views.

Inspector
The Inspector is a key component of Merlin Project and contains context-sensitive options
for editing all selected objects within the project. The Inspector provides you with an
overview of all the functions you need to edit your project and its contents. It can be found
on the right-hand side of the work area.
You can show or hide the Inspector by clicking the icon of the same name on the toolbar. If
needed, you can expand or collapse the content in the Inspector just by clicking the
triangle icons. This limits the number of options visible to the required amount.
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You can have the Inspector appear in a separate window instead of the
main window. To do this, click »Preferences« then go to the »General«
tab followed by »Inspector position«.

Details
This section lists the project attachments. If you have a lot of attachments, it is a good
idea to list them by Attachment Type. As with the outline and other views, you can use
various columns.
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Details

Menu bar
The menu bar contains commands for using Merlin Project. You can find these commands
under the following menu options:

Merlin Project

About Merlin Project
Opens a window displaying information about the program version you are using.

Preferences…
Opens the »Preferences« window so you can configure Merlin Project.
Preferences - General
You can find the general options for using Merlin Project under Preferences > General.

Application language

The Application language option lets you choose which language you want to use for the
application. By default, the system language is used. If you want to use a different
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language in Merlin Project to the language used in OS X, change it by selecting another
language from the drop-down menu.



For example, OS X can run in German, while Merlin Project runs in
English.

Inspector position

The Inspector Position option contains two Inspector position settings.
• Integrated
• Separate window
By default, the Inspector is integrated into the main window and part of it. Select the
Separate window option to release the Inspector from the main window and use it in a
separate window.
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Merlin Project



You may want to use the Inspector in its own separate window when
using multiple monitors. You can position the main window on the main
monitor and the Inspector on the secondary monitor. This frees up
space in the main window for the content.

Upon external changes to files

The Upon external changes to files option contains three options which let you choose
how changes made to File type attachments are handled.
• Ask what to do
• Ignore
• Integrate into old version
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By default, the option is set to Ask what to do. You will be prompted whether you want to
save the file as a new duplicate version with the changed content or if the new content
should be adopted in the old file version.
Ignore ignores the changes and leaves the file in its original state.
Integrate into old version integrates the changes into the old file version.
Software Update

You can choose between three settings for the Software Update option:
• Automatically download and install updates
• Just notify if there are updates
• Don’t check for updates

The Automatically download and install updates option searches for updates
automatically. If a new program version is found, it is downloaded and installed
automatically.
The Just notify if there are updates option notifies you of updates. You then download
and install the update manually.
The Don’t check for updates option deactivates the update search.
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Always use the latest version of Merlin Project. Using older program
versions may lead to problems and produce unanticipated results.

Merlin Project

Preferences - Licenses
You can manage your licenses under Preferences > Licenses. The preferences let you
activate new application licenses, remove existing licenses, request lost licenses, and view
the licensed functions.
License Files

Under the License Files tab, you will find a list of license files that are in use. Here, you can
obtain information about the licenses.

If no files exist, you can purchase them directly from our online store by clicking Buy.
You can add or remove licenses from the list by clicking »+« or »-«.
Click Lost License to request lost or deleted license files.



Please store purchased license files securely as they are a valuable
asset.

Using license files

You can activate the purchased license file(s) by double clicking it/them. For this purpose,
Merlin Project should already be installed on your Mac in the »Programs« folder.
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Otherwise, click the »+« icon in Preferences > Licenses and select the license file(s) from
the Add License dialog.
Another way of installing the license file(s) is to drag & drop the license file(s) directly onto
the Preferences > Licenses window.

All installed license files appear in the list and can be removed afterwards by clicking the
»-« icon.
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Merlin Project

If you remove a license file, a notification dialog will appear. The file will then be deleted
directly. If you do not want that to happen, search for the license file under the path shown
and store it in a secure place before deleting it.

Updating from earlier versions of Merlin
If you have older Merlin license files, these can be reused in Merlin Project using update
licenses.
Updating from Merlin 1 to Merlin Project
If you already have a Merlin 1 license file, you can drag & drop it onto the list in the
Preferences > Licenses window. Following that, you must drag & drop the associated
update license from Merlin 2 and Merlin 3 to the window.
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You will have used all the license files required for the update once the
red title »Merlin Project is not licensed« turns to the black title »Merlin
Project is licensed«.

Updating from Merlin 2 to Merlin Project
If you already have a Merlin 2 license file, you can drag & drop it onto the list in the
Preferences > Licenses window. Following that, drag & drop the associated update license
from Merlin 3 onto the window.
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Merlin Project



You will have used all the license files required for the update once the
red title »Merlin Project is not licensed« turns to the black title »Merlin
Project is licensed«.
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Preferences – Templates
The »Templates« tab under Preferences in Merlin Project lets you use and manage your
own project files as templates:

This lets you create and use folders containing project files as templates for Merlin Project.
Click »+« and select a folder containing projects. The "Languages for default templates"
option lets you set the language for project file templates.
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Merlin Project

Preferences - Library
The »Library« tab under Preferences in Merlin Project is divided into two further tabs:
• Folders
• Address books
Folders

Under the »Folders« tab, you can configure options for the Library built into Merlin
Project.

The Writeable folder: option lets you change the default folder where all Library content is
stored or open the folder in the Finder application.
Click the arrow icon to open the Library folder in the Finder application.

| Handbook for Merlin Project 4

31



By default, the folder is located in the user folder. You can access it
under the following path on the local volume of your Mac: HD > Users >
User name > Library > Containers > net.projectwizards.merlinproject >
Data > Library > Application Support > net.projectwizards.merlinproject
> Library

You can change the default folder by clicking the Default drop-down menu and configure
another folder to use with the Library. To do this, click Select in the drop-down menu. A
dialog will open letting you set a new Library folder.

Read-only folders
You can configure additional folders with content for the Library in the Read-only folders
list. Click »+« to add new folders or »-« to remove them.

The folders contained in the folder you selected will be available automatically, including
their content, in the Library. The folders are read-only and cannot be populated with new
content or edited in the Library. To do this, you need to add new content directly to the
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Merlin Project

original sub-folders using the Finder application. The new content will then appear
automatically in the Library.
Address books

Under the »Address books« tab, you can customize and use address books from various
applications and directory services with LDAP functionality for use with the Library built
into Merlin Project.

The Show OS X contacts option activates/deactivates whether contacts are shown in the
Library from the »Contacts.app«.
The Show Microsoft Outlook contacts option activates/deactivates whether contacts are
shown in the Library from the »Outlook.app« which is part of the Microsoft Office suite.
LDAP Directory Services
You can enter LDAP servers in the LDAP Directory Services list. This lets you use contacts
from an LDAP directory service with the Library.
Click »+« to enter information to connect to and use an LDAP directory service.
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Click »-« to remove an entry. To edit entries, click »Edit«.

Reload / Show Library

On the bottom right-hand edge of the Preferences settings for the _Library, you will see
two buttons:
• Reload
• Show Library
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Merlin Project

The Reload button updates all content from the folders/address books in the Library.
The Show Library button opens the Library window.
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Preferences - Accounts
The »Accounts« tab under the Preferences option for Merlin Project contains options to
create the following accounts:
• FTP
• SMTP
• WebDAV

This lets you use servers with the above-mentioned protocols for use with Merlin Project.
Select the server protocols from the context menu by clicking the »+« icon. On the righthand side, enter the particular server’s details.

36

Merlin Project



Here, a Merlin Sync Server has been entered as an Account for use with
Merlin Project
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Preferences – Access to Folders
The »Access to Folders« tab under Preferences in Merlin Project offers access to box.com
folders and allows any other cloud services to be set up:

This allows projects to be synced automatically between the above-mentioned cloud
services and Merlin Project.
You can add a folder by clicking »+«. You can also drag & drop folders into the window.
The "Ask for permission when opening documents" option displays a dialog when opening
documents.

Check for Updates…
Checks for updates to Merlin Project

Services
This menu contains all the services provided by the system. You can adjust these under
the »Services Preferences« option.

Hide/Show Merlin Project
Hides/shows all open Merlin Project windows.
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Merlin Project

Hide/Show Other Windows
Hides/shows all other active application windows that are open.
Merlin Project

Show All
Shows every window of every application.

Quit Merlin Project
Quit Merlin Project.
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File
This menu contains options for working with project documents.

New
Opens a new blank project.

New From Template
Opens a new project based on a template. The templates available appear in the dropdown menu.

Open
Opens a project file vial the "File Open" dialogue, In this dialogue all file types will be
displayed, which can be opened in Merlin Project. These are:
• OPML,
• CSV (in several settings for line and field separation, encoding etc.),
• XML (all Merlin Project fields),
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File

• NovaMind 4 & NovaMind 5,
• FreeMind,
• MindManager,
• MS Project (direct import of .mpp files from MS Project 2003, 2007, 2010 and
2013, as well XML and MPX)
• Omniplan 2,
• Merlin Project & Merlin 2
Import
The import function in Merlin Project lets you use a variety of file formats from other
applications. You can import documents in two ways:
• Via the menu File > Open
• By dragging & dropping a document onto the Merlin Project program icon
• By dragging & dropping a document onto the project window
All readable formats will be opened automatically. If a format is not supported, it cannot be
opened in Merlin Project.
Importing via the menu »File > Open«

Importing via the menu File > Open works the same way as opening Merlin Project files.
You can access the Open window directly using the keyboard shortcut [cmd + O].

All documents are shown in the Open dialog. File formats not supported by Merlin Project
are grayed out (1); readable files, which can be imported, are not grayed out (2) and can be
selected (3).
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Importing by dragging & dropping onto the program icon

In Merlin Project, all readable documents can be opened/imported directly by simply
dragging & dropping them onto the program icon (in the dock or in the Finder application).

A Microsoft Project MPP document is being imported by dragging & dropping it onto the
program icon



If a new project window does not open displaying content, it is highly
likely that the document format is not recognized. This means that
Merlin Project does not support this format.

Importing by dragging & dropping onto a project window

You can drag & drop documents directly onto a project window, regardless of whether it is
a blank or populated project.

If the project is already populated with content, you can either drop the document content
in a group or position it between two activities based on the blue markings.
Once you have dropped the file onto the project window, you will be asked whether you
want to copy the content to the project or create a new sub-project.
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When copying, the content is included in the project and the project file remains
unaffected.
In the case of sub-projects, a separate sub-project is created for the content which
remains connected to the original project. Changes are transferred to the other project
upon saving.
CSV

The CSV file format contains lists and table content with comma-separated values. This
lets you export content from popular spreadsheet programs such as Excel or Numbers and
import it into Merlin Project.



For further information on the CSV file format, visit Wikipedia.

When opening CSV files, the window shown will be displayed. This lets you assign data
records from the output document (1) to the fields in Merlin Project (2).
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For this purpose, you can drag & drop the individual fields onto the right-hand section and
assign them to the fields listed there. Alternatively, you can click the Map automatically (3)
button and Merlin Project will take care of it.



The option to automatically map column fields from the output
document only works reliably if the fields in the output document have
the same descriptions as the fields in Merlin Project.

Just click the Show all fields button to display all available Merlin Project fields in the righthand section.
In general, you must create a CSV file from a spreadsheet. It is important that the file
contains a header with the column descriptions and the column content. For example, a
»Duration« or »Work« column should only contain digits.
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File

Example of a Microsoft Excel table saved as a CSV document.

The result of importing a document into Merlin Project
CSV options

There is no uniform CSV file format standard so the output varies depending on the
application. As such, customization options are available to ensure importing works
without a hitch.
• Fields are separated by
• Fields are wrapped with
• Encoding
• Default duration unit
• Outline levels
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• Header rows
• Create columns for unmapped fields
To ensure information from a CSV file is imported correctly, you should establish
beforehand which format the CSV file is in (comma separated or semicolon separated).
If you do not know this, you can configure the options in Merlin Project to correctly import
the fields from the CSV file into a project.
Fields are separated by

You can separate the field information contained in the CSV files using different
characters. The ones used depend on the program the CSV is exported from and the CSV
export settings in the program itself.
Choose from the following separators in the drop-down menu under the Fields are
separated by option:
• Tabs
• Semicolon
• Colon
• Comma



If you open a CSV file using a text editor (e.g. TextEdit), you can quickly
establish which separators have been used.

Fields are wrapped with
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You can wrap the field information contained in the CSV files using different characters.
The ones used depend on the program the CSV is exported from and the CSV export
settings in the program itself.
Choose from the following options in the drop-down menu under the Fields are wrapped
with option:
• Nothing
• Single quotes
• Double quotes

Encoding

The field information contained in the CSV files can be saved using different encoding
formats. The ones used depend on the program the CSV is exported from and the CSV
export settings in the program itself. Additionally, the encoding formats used also depend
on the operating system and the system language.
Choose from the following options in the drop-down menu under the Encoding option:
• Western (Mac OS Roman)
• Western (ISO Latin 1)
• Western (ISO Latin 2)
• Western (Windows Latin 1)
• Western (Windows Latin 2)
• Unicode (UTF-8)
• Unicode (UTF-16)
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The chosen encoding can be decisive for how certain characters are
displayed such as special characters (€$§ etc.) and vowel modifiers (öäü
etc.).

Default duration unit

In the field information contained in the CSV files, you can assign a specific duration unit to
digits. This means that if a field contains a digit, this will be used with the chosen duration
unit when imported. For example, »1« will become »1 day«.
Choose from the following options in the drop-down menu under the Default duration unit
option:
• Seconds
• Minutes
• Hours
• Days
• Weeks
• Months
• Quarters
• Years
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If the default duration units in the imported project do not match the
desired units, it is worthwhile importing the project again and selecting
the desired default duration unit.

Outline levels

You can assign outline levels to the field information contained in the CSV files. If
hierarchies are to be taken into consideration in the import, you can do this by changing
the number of outline levels by entering a number under the Outline levels option.
Header rows

You can assign header rows to the field information contained in the CSV files. You can
customize the content accordingly by changing the Header rows option.
Columns for unmapped fields

If you want to create separate columns for unmapped fields from the CSV file, it is
worthwhile activating the checkbox under the Create columns for unmapped fields option.
Usually, fields are mapped manually or automatically to the existing fields.

It is really easy to map fields manually from the CSV file to the available fields in Merlin
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Project. Just drag & drop the CSV file fields from the left-hand side onto the fields listed
on the right-hand side. You can display all fields in Merlin Project by clicking the »Show
all fields« button.
OPML

The OPML format (Outline Processor Markup Language) was originally designed for
outlines. It is an XML format which is excellent at modeling hierarchically structured
information as used in outlines and to-do lists.



For further information on the OPML file format, visit Wikipedia.

OPML files are imported in the same way as all other file formats. As with the CSV format,
an import window is available which lets you drag & drop fields from the data record onto
the fields in Merlin Project.

Moreover, you can choose from four additional options for importing OPML files.
• Map automatically
• Show all fields
• Default duration unit
• Create columns for unmapped fields
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Click the Map automatically button to map the fields from the OPML file to the fields of the
same name in Merlin Project. For this to work without a hitch, the fields in the OPML file
must have the same name as the columns in Merlin Project.
Click the Show all fields button to display all the columns available in Merlin Project in the
right-hand section of the import window.
The Default duration unit option controls the duration units used.
In the field information contained in the OPML files, you can assign a specific duration unit
to digits. This means that if a field contains a digit, this will be used with the chosen
duration unit when imported. For example, »1« will become »1 day«.
Choose from the following options in the drop-down menu under the Default duration unit
option:
• Seconds
• Minutes
• Hours
• Days
• Weeks
• Months
• Quarters
• Years



If the default duration units in the imported project do not match the
desired units, it is worthwhile importing the project again and selecting
the desired default duration unit.

Combine Documents
Opens the »Combine Projects« window. This lets you combine and edit individual projects
in one document. You can also continue editing the projects independently of each other.
Combined Projects
This function lets you combine multiple projects into one Main Project. A main project
provides an overview of the sub-projects combined within it. Changes made to individual
sub-projects are kept synchronized in the main project, and vice versa, after saving.
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The quickest way to create a main project with at least two sub-projects is as follows:
1. Create a new blank project
2. Name the project so you can easily identify it (e.g. Master Project)
3. Move at least two Merlin Project project files from the Finder application to the
outline of the new Master project

The program will prompt you to do one of the following once these three steps are
completed:
• Cancel
• Create sub-project
• Copy Content
The Cancel option cancels the creation of a combined project.
The Create sub-project option creates a combined project where all changes to subprojects are kept synchronized once saved.
The Copy Content option copies the content from the project files to the empty project
thereby creating a new project which retains the content at the time of copying. The
individual projects remain separate entities. Changes to the main project are not

52

File

transferred to the individual projects, and vice versa.
If the projects in the main project are created as sub-projects, changes to the individual
sub-projects are transferred automatically to the main project on saving, and vice versa.

Open Recent
Recent projects are listed here which can be opened. To clear this list, click »Delete
Items«.

Close | Close All (alt key)
Closes the active project window. If you keep the alt key held depressed when executing
the command, the command changes to »Close All…« and all open application windows
will close.

Save
Saves the project. The save dialog will be displayed which lets you name the project and
save it to a path for later use.

Duplicate | Save As (alt key)
The »Duplicate« command creates a copy of the project file. If you keep the alt key held
depressed when executing the command, the command changes to »Save As«. Like the
»Save« command, the save dialog will be displayed letting you save a copy of the project
file under a new name and path.

Rename …
The »Rename« command lets you enter a new name for the project file. The storage
location is not changed when you rename a project file.

Move …
The »Move« command lets you move the project file to another storage location. You can
select the new storage location in the selection dialog.

Save As Template
This option lets you save the open project as a template for use for later projects. Any
project saved this way will appear in the »New From Template« list for creating new
projects based on a template.

Revert to Saved
This system option lets you revert to the last saved version. If you do so, you will lose all
changes since the project was last saved.
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Merlin Server …
Opens the »Server Document Management« window

Integrate Changes
Integrates changes into an existing project.

Export
Opens the export dialog. A host of formats and export functions are available letting you
save the project for use in other applications. This function only becomes active if the
project has already been saved.
Export
The export function in Merlin Project lets you use numerous file formats from other
applications. To use this function, click File > Export or use the keyboard shortcut [alt +
cmd + E].
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Depending on the main window view, some export formats are not
available. If you switch views, the particular export function can then be
used and the content from the view created in the desired format.

File

You can choose from the following export formats in Merlin Project:
• Image
• CSV
• FreeMind
• Calendar
• Merlin Project
• HTML
• MindManager
• MS Project
• NovaMind
• OPML
• XML



You can scroll the list of export formats as not all formats are visible at
first glance.

Image

»Image« export options vary depending on the view you are in. If you want to export an
image in the Work Breakdown > Activities view, you can select which Gantt and Outline
parts you want to export:
• Outline and Gantt
• Outline only
• Gantt only
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If you are in another view, you can choose the following display options for the exported
image:
• With shadows
• With gradients
• With background
• With watermark
The With shadows option exports the shadows cast by the objects in the project within the
image. To deactivate this option, remove the check mark.
The With gradients option exports the color gradients in the project objects within the
image. To deactivate this option, remove the check mark.
The With background option exports the background used in the project within the image.
To deactivate this option, remove the check mark.
The With watermark option exports a watermark within the image. To deactivate this
option, remove the check mark.
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If you activate this option, you can choose from further options:
• Image
• Position
• Scaling
• Level
• Opacity
The Image option is a field you can drag & drop image files onto. If you drag an image onto
this field using the mouse, it will be used as a watermark once you drop it.
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You can remove the image whenever you want and replace it with another image. All you
need to do is click x icon to remove the image. The field is then blank again ready for you
to add another image.

The Position option lets you position the watermark in the image document to be exported.
Right-click one of the squares to set the watermark position. It is centered by default.

The watermark is positioned on the bottom left shown here.
The Scaling option lets you adjust the size of the watermark to suit the image document.
Choose from the following options in the drop-down menu:
• Fit
• Fill
• Stretch
• Manual
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If you select Manual, you can enter the percentage you want to scale the watermark by.

The Level option contains two options:
• Below content
• Above content
This lets you position the watermark above or below the project content within the image.
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The Opacity option lets you increase the transparency of the watermark. You can adjust
the opacity using a percentage value. 100% is opaque; 0% is transparent.
Format
You can select various file formats from the Format drop-down menu for the file you want
to export.

These are:
• PDF Vector Image
• PNG
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• JPEG
• JPEG 2000
• TIFF
• BMP
• GIF
FreeMind

The »FreeMind« export function lets you create Mind-Map projects for the free-of-charge
program FreeMind.



The free software program FreeMind is available for all popular platforms
and can be downloaded from Sourgeforce. The software requires the
Java Runtime Environment.

You can choose between two options for this export function:
• Export with HTML view
• Sub-projects
The Export with HTML view option creates an HTML view of the project when exporting for
FreeMind.
The Sub-projects option lets you make specific selections in the case of combined
projects.
HTML
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The »HTML« option creates a folder with a static HTML project of the current view. This
lets you open and view the exported project in all popular Web browsers.
The »Media« drop-down menu lets you select options for the files used in the project.

• None
• Thumbnails only
• Thumbnails and originals
The »None« option does not export any media from the project to the HTML folder.
The »Thumbnails only« option exports a preview of each item of media from the project to
the HTML folder.
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The »Thumbnails and originals« option exports both a preview and each original file from
the project to the HTML folder.
Calendar

The »Calendar« export function creates an ICS document which can be used as a
calendar with the Calendar app as well as other programs supporting the ICS format.



ICS is a standard format supported by many calendar applications.

You can choose between three options for this export function:
• Export activities
• Export assignments
• Export events
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Each option contains additional configuration options with specific conditions. You can
edit any condition by clicking the magnifying glass icon.

Depending on the information stored in the project, you can configure these for calendar
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export.
The exported ICS file can be emailed or sent using alternate means to other users and
opened using a calendar application. The project is exported in a static state, meaning the
file is not synchronized or similar.

An ICS file exported for use in a calendar application.
Merlin Project
The »Merlin Project« export function creates a copy of the current Merlin Project
document.

MindManager

The »MindManager« export function creates a file which can be opened using the
MindManager software program.

»MindManager« software is available for the PC and Mac. For further information, visit
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MindJet.



The »MindManager« file format is used by many mind-map software
programs. For further information on mind-maps, see Wikipedia.

MS Project

The »MS Project« export function creates an XML file which can be opened using the MS
Project software program.

The Sub-projects option lets you make specific selections in the case of combined
projects.



»MS Project« is developed and sold by Microsoft and is ideal for
creating and editing projects. For further information on MS Project, see
Wikipedia.

NovaMind

The »NovaMind« export function creates a file which can be opened using the NovaMind
5 software program.

66

File



»NovaMind 5« is a mind-map software program available for the Mac
and PC. For further information, visit NovaMind.

OPML

The »OPML« export function creates a file that can be used in OmniOutliner and other list
programs.

The With resource assignments option includes all assigned resources in the project in the
OPML file.



The OPML format is used by many software programs and is ideal for
creating hierarchically structured lists and checklists.

Text

The »Text« export function exports a CSV document which can be used with MS Excel
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and other programs. If you want to export a CSV file of the content when in the Work
Breakdown > Activities view, you can configure various CSV settings.

The CSV file format contains lists and table content with comma-separated values. This
lets you export content for use with popular spreadsheet programs such as Microsoft
Excel and Numbers.



For further information on the CSV file format, see Wikipedia.

You can choose from the following drop-down menus for exporting text:
• Separate fields with
• Wrap fields with
• Line ends for
• Encoding
• File extension
• Default duration unit
You can also choose from the following options:
• With column titles
• Outline levels
• Dates with times
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• With resource assignments
Text - Separate fields with

The »Separate fields with« drop-down menu contains a selection of separators for the
text (CSV) file. The separators separate the field content.

Depending on the program and the CSV import/export format used, it may be helpful to
change the separators to import/export the content correctly.
You can choose from the following separators in the drop-down menu:
• Comma
• Tabs
• Semicolon
• Colon
You can separate the field information contained in the CSV files using different
characters. The ones used depend on the program the CSV file is being exported for and
the CSV import settings in the program itself.



If you open a CSV file using a text editor (e.g. TextEdit), you can quickly
establish which separators have been used.
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Text - Wrap fields with

You can wrap the field information contained in the CSV files using different characters.
The ones used depend on the program the CSV file is being exported for and the CSV
import settings in the program itself.

You can choose from the following options in the drop-down menu:
• Single quotes
• Double quotes
Text - Line ends for

You can save the line ends contained in the CSV files using different characters. Most
current programs can detect these line ends automatically. It may, however, be necessary
to configure the line ends used for older systems and some programs.
You can choose from the following options in the drop-down menu:
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• Mac/UNIX
• Windows
• Classic Mac

Text - Encoding

You can save the field information contained in the CSV files using different encoding
formats. The ones used depend on the program the CSV file is being exported for and the
CSV import settings in the program itself. Additionally, the encoding formats used also
depend on the operating system and the system language.
You can choose from the following encoding options in the drop-down menu:
• Western (Mac OS Roman)
• Western (ISO Latin 1)
• Western (ISO Latin 2)
• Western (Windows Latin 1)
• Western (Windows Latin 2)
• Unicode (UTF-8)
• Unicode (UTF-16)
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The chosen encoding can be decisive for how certain characters are
displayed such as special characters (€$§ etc.) and vowel modifiers (öäü
etc.).

Text - File extension

This option lets you select the file extension of the exported text file.
You can choose between two file extensions:
• CSV (Standard)
• TXT
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Text - Default duration unit

In the field information contained in the CSV files, you can assign a specific duration unit to
digits. This means that if a field contains a digit, this will be used with the chosen duration
unit when imported. For example, »1« will become »1 day«.
You can choose from the following duration units in the drop-down menu:
• None
• Seconds
• Minutes
• Hours
• Days
• Weeks
• Months
• Quarters
• Years
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If the default duration units in the exported project do not match the
desired units, it is worthwhile exporting the project again and selecting a
new default duration unit.

Text - Advanced Options

• With column titles
• Outline levels
• Dates with times
• With resource assignments
The With column titles option exports column titles in the CSV file.
The Outline levels option exports the project’s outline levels in the CSV file.
The Dates with times option exports date information including times in the CSV file.
The With resource assignments option exports resources assigned in the project in the
CSV file.
XML

the »XML« export function creates a Merlin XML file.
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You can choose from the following XML export options:
• Calculated values
• User interface configuration
• Media
• Sub-projects
The Calculated values option includes all calculated values in the project in the XML file.
The User interface configuration option includes the user interface configuration in the
XML file.
The Media option includes all attached files in the project in the XML file.
The Sub-projects option lets you make specific selections in the case of combined
projects.



The XML format is used by many programs and can be read using a text
editor. For further information on the various XML formats, see
Wikipedia.

Send as email
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Send as Email
The »Send as Email« function lets you email all export formats available in Merlin Project.
To use the function, click File > Send as Email.



Depending on the main window view, some formats are not available to
email. If you change views, you can then use the send function and email
the content in the view in the desired format.

In Merlin Project you can choose from the following formats for emailing:
• Image
• CSV
• FreeMind
• HTML
• Calendar
• Merlin Project
• MindManager
• MS Project
• NovaMind
• OPML
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• XML



You can scroll the list of formats for emailing as not all formats are
visible at first glance. The formats are the same as the export formats.

Publish

Options are available here letting project content be published and subscribed to. These
are divided into Settings, Publish, and Update.
Settings
This dialog lets you define the publishing and updating actions.
Publish
If one or more publishing and updating actions are defined in the Publish settings you can
select them here.

Actions
Calls available AppleScripts as Actions. Using the »Show Scripts Folder«, you can open
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the folder for the AppleScripts. Any AppleScripts saved in that folder, will appear in the
»Actions« list.



Actions and AppleScripts used for collaboration to other applications
can be found on the Merlin Project website.

Project Settings
Shows the settings for general project presets in the Inspector. These include date, work,
calendar, and utilization presets for the active project. You can also display the project
settings by clicking the icon of the same name in the icon bar. When opening a new
project, the settings are displayed by default in the Inspector.

Work Area
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Contains options for collaborative working, whereby a distinction is made between public
and private work.
Public
Working on a project in »Public« mode transfers all changes to the project directly.
Private
Working in »Private« mode means you only work locally on the project and changes are
not transferred to other project attendees.
Integrate Changes

Use this option to integrate changes made in »Private« mode into the project.
Publish Changes

You can use this option to publish changes made in »Private« mode for all attendees.
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Discard Changes

You can use this option to discard changes made in »Private« mode, thereby deleting
them.

Page Setup
Opens the selected printer’s Page Setup settings.



This option is only active in the Report view. For all other views, the page
setup can be configured under the Print menu.

Print
Opens the Print menu. This lets you select which printer you want to use for printing.
Additionally, various options are available to create PDF files by clicking the »PDF« button.
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Edit
This menu contains options for editing project content.

Undo
Undoes the last step. Press the option multiple times to undo previous steps
chronologically. The application supports persistent undo. This means additional steps
can be undone even after the file has been closed and reopened.

Redo
Redoes the last step undone. Press the option multiple times to redo previous steps
chronologically. This option is only active if you have used the »Undo« option at least
once.

Cut
Cuts the selection and stores it on the clipboard. The cut content only remains available on
the clipboard until you press »Copy« or »Cut« or switch your computer off. You can only
store copied or cut content on the clipboard.

Copy
Copies the selection and stores it on the clipboard. The copied content only remains
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available on the clipboard until you press »Copy« or »Cut« or switch your computer off.
You can only store copied or cut content on the clipboard.

Paste
Pastes content from the clipboard to the active project if you have stored content on the
clipboard using the »Copy« or »Cut« commands.

Paste and Match Style
Pastes content from the clipboard. The content you paste will match the style currently
active in the application. Examples include the font and size.

Clear
Clears the selection.

Select All
Selects all content in the active project.

Copy Link
Copy the unique link to this document file and the current selection for sharing with
others.

Milestone
Change the selection to a milestone

Clear Actual Values
Clears the actual values of the selection.

Completion
Change the completion in % for the selection.
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Resource Leveling
This menu option contains resource leveling options. You can use these to level overutilization and under-utilization in the project.
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Leveling Settings
Shows the settings for resource leveling in the Inspector. These let you determine the
utilization thresholds for over-utilization and under-utilization in percentage terms.
Level All
Levels all resource utilizations in the project.
Reset All
Resets all resource utilizations in the project to their original state.
Level Selection
Levels all selected resource utilizations in the project.
Reset Selection
Resets all selected resource utilizations in the project to their original state.

Find
This menu option contains several options for searching within the project.
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Find
Activates the search function. A search box will appear in the program window. Search
results will be highlighted in yellow in the project.
Find Next
Displays the next search match if multiple results are found.
Find Previous
Displays the previous search match if multiple results are found.
Use Selection For Find
Uses a selection as the search term.
Jump to Selection
Displays the selection used for the search.
Jump to Current Date
Displays the current date in the project view.
Jump to …
Brings up a search box allowing you to jump to an activity directly by entering a
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consecutive number (#), WBS code or another numbering.

Spelling and Grammar
This menu option contains spelling and grammar checking options provided by the
operating system.



You need to select text to activate the options in the menu. This applies
to all options provided by the system described in the following.

Show Spelling and Grammar
Displays the »Spelling and Grammar« window. This allows you to check the spelling and
grammar of the selected text.
Check Document Now
Checks the selected text for spelling and grammar mistakes. Errors are highlighted in the
default color.
Check Spelling While Typing
If this option is checked, content is checked while you type and underlined in red if
mistakes are found.
Check Grammar With Spelling
If this option is checked, grammar and spelling will be checked.
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Correct Spelling Automatically
If this option is checked, spelling will be checked and corrected automatically.
Substitutions
This menu option contains text substitution options provided by the operating system.
These options can be configured in the operating system under »System Preferences >
Keyboard > Text«. (http://support.apple.com/kb/PH14294?viewlocale=en_US)

Show Substitutions
Shows the »Substitutions« window.
Smart Copy/Paste
If this option is checked and text is then pasted, spaces around the pasted text are
inserted/removed automatically if required.
Smart Quotes
If this option is checked, quotation marks are always used when entering text.
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Smart Dashes
If this option is checked, long dashes are always used when entering text.
Smart Links
If this option is checked, URLs are converted into clickable links. For example, the string
"www.projectwizards.net" is converted into a link which opens the Web page when clicked.
Likewise, "mailto:person@mail.com" is converted so a window opens allowing you to email
the particular address.
Data Detectors
If this option is checked, dates, locations, and contacts will be detected automatically
allowing them to be saved in your address book or calendar.
Text Replacement
If this option is checked, all text elements entered in »System Preferences > Keyboard >
Text« will be replaced with another text element.

Transformations
This menu option contains all text transformation options provided by the operating
system.
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Make Upper Case
This option makes all selected letters uppercase.
Make Lower Case
This option makes all selected letters lowercase.
Capitalize
This option capitalizes the first letter of every word selected.

Speech
This menu option contains text-to-speech output options provided by the operating
system. You can configure the speech-output voice under »System Preferences >
Dictation & Speech > Text to Speech«.

Start Speaking
This option reads the selected text using the system’s default voice.
Stop Speaking
This option stops the text being read aloud.
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Special Characters …
Shows the »Special Characters« window. This lets you select and use special characters
and symbols in texts.

Start Dictation …
This option provided by the operating system lets you dictate text. You can configure this
function under »System Preferences > Dictation & Speech > Dictation«
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Format
This menu contains text formatting options.

Show Fonts
Shows the »Fonts« menu provided by the operating system. This lets you change various
parameters of the selected text.

Bold
Makes the selected text bold. This option remains active until you uncheck the box by
clicking it again.

Italic
Italicizes the selected text. This option remains active until you uncheck the box by
clicking it again.

Underline
Underlines the selected text. This option remains active until you uncheck the box by
clicking it again.

Outline
Outlines the selected text. This option remains active until you uncheck the box by clicking
it again.

Bigger
Increases the selected font by one font size.

Smaller
Decreases the selected font by one font size.
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Show Colors
Shows the »Colors« window provided by the operating system. This lets you make the
selected text any color you want.

Copy Style
Copies the selected text’s style.

Paste Style
Uses the copied style for the current text selection.
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Insert
This menu contains options for working with content.

Activity
Creates a new activity in the active document. If you have not made a selection in the
outline, the activity will be created in the last row. If you have made a selection in the
outline, the new activity will be created directly in the row below.
Insert new row
You can add a new activity row to the project structure. To do this, select the upper
activity under which you want to add the new activity row.
In the example, a new activity is to be added between row #2 (activity 2) and row #3
(activity 3).

First you need to select the upper activity by clicking it. In the example, row #2 (activity 2)
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You can now create a new activity.



The easiest way is to use the keyboard shortcut [cmd + N].

The New Activity shifts the content of row #3 as well as all subsequent activities down one
row in the structure. The New Activity is now positioned in Row #3 and you can add a title
to it.

Milestone
Creates a new milestone in the active document. If you have not made a selection in the
outline, the milestone will be created in the last row. If you have made a selection in the
outline, the new milestone will be created directly in the row below.

Child
Creates a new activity indented one level below the overlying activity/milestone. This
overlying activity/milestone will be converted automatically into a group (bold).

Aunt
Creates a new activity outdented one level outside the selected group.

Predecessor
Creates an activity linked to the selection as a predecessor (finish-start).
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Successor
Creates an activity linked to the selection as a successor (finish-start).

Assignment
Creates a new resource assigned to the selection.

Attachment
This menu option contains options for creating attachments for the current selection
within the project.

Checklist
Creates a new checklist attached to the selection.
Event
Creates a new event attached to the selection.
File
Creates a new file attached to the selection.
Information
Creates new information attached to the selection.
Issue
Creates a new issue attached to the selection.
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Risk
Creates a new risk attached to the selection.

Project …
Opens a dialog letting you select an existing project. This allows you to add and use an
additional project in the open project.

Column
Creates a new column. A drop-down menu with the column content available for selection
will be displayed. You can also define the columns yourself.
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Structure
This menu contains commands for editing the project structure. It lets you apply various
functions to selected content in the outline or bar chart.

Indent
Indents the selected elements (milestones, activities) in the outline. Overlying objects are
converted automatically into a group.

Outdent
Outdents the selected elements (milestones, activities) outside the overlying group. If you
outdent every item of content from a group, this group is converted into an activity. You
cannot outdent top level elements (milestones, activities).

Move Up
Moves the selected elements (milestones, activities) one position higher in the outline
sequence.

Move Down
Moves the selected elements (milestones, activities) one position lower in the outline
sequence.

Expand
This menu option contains options for expanding groups in the outline.
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All
Expands all groups in the outline. Underlying groups remain collapsed.
Selection
Expands all selected groups. Underlying groups remain collapsed.
Complete Selection
Expands all selected groups including all subgroups.
In Steps
Expands all groups one level at a time.
Assignments
Expands all activities which have at least one assignment.

Collapse
This menu option includes options for collapsing groups in the outline.

All
Collapses all groups in the outline.
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Selection
Collapses all selected groups. Underlying groups remain collapsed/expanded.
Complete Selection
Collapses all selected groups, including all subgroups.
In Steps
Collapses all groups one level at a time.
Assignments
Collapses all activities which have at least one visible assignment.

Freeze Sorting
Freezes the sorting for the currently active column.

Link
This menu option contains options for linking at least two marked milestones, activities,
groups or assignments. This creates a chronological dependency between the linked
elements.

Finish - Start
Links the selected elements with the finish-to-start dependency. The next element will
now start once the preceding one has been finished. The exception here is when you use a
slack duration as the slack duration you entered influences the finish.
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Use the keyboard shortcut ctrl – cmd - L to create a Finish - Start link
automatically.

Finish - Finish
Links selected elements with the finish-to-finish dependency. Both elements now finish at
the same time. The exception here is when you use a slack duration as the slack duration
you entered influences the finish.

Start - Start
Links selected elements with the start-to-start dependency. Both elements now finish at
the same time. The exception here is when you use a slack duration as the slack duration
you entered influences the finish.

Start - Finish
Links selected elements with the start-to-finish dependency. Both elements now finish at
the same time. The exception here is when you use a slack duration as the slack duration
you entered influences the finish.

Disconnect
Disconnects all links for the selection made.

Assignments
This menu contains options for creating resource assignments.
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Structure

New Resource
Creates a new resource and assigns it to the selected element.
Remove all Assignments
Removes all assignments in the selected element.
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View
This menu contains options for displaying content and programs.

Work Breakdown
This menu option lets you view and edit the project and its content in the built-in
»Activities« and »Earned Value« views. Additional views are user specific.
Activities
This view shows the project content in the form of an outline and a bar chart (Gantt chart).
Earned Value
This view shows the project content for the earned value analysis. This adds a column set
with corresponding functions to the outline.
Edit
Shows the view editing dialog. Both the built-in and custom views are listed. You can
create custom views by clicking the plus icon.

Net Plan
This option lets you view and edit the project and its content in the built-in »Mind Map«,
»Net Plan«, and »Organizational Chart« views. Additional views are user specific.
Mind Map
This view shows the project content in the form of a mind map. This project view is ideal
for displaying project structures graphically.
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Net Plan
The view shows the project content in the form of a net plan. It is another way of displaying
the project structure graphically.
Organizational Chart
This view shows the project content in the form of an organizational chart. It is another
way of displaying the project structure graphically.
Edit
Shows the view editing dialog. Both the built-in and custom views are listed. You can
create custom views by clicking the plus icon.

Resources
This option lets you view and edit the resources used within the project using the built-in
default views. Additional views are user specific.
Default
This view shows the resources used in the project. A default column set is used for the
resources.
Edit
Shows the view editing dialog. Both the built-in and custom views are listed. You can
create custom views by clicking the plus icon.

Assignments
This option lets you view the assignments used within the project using the built-in
»Utilization« view. Additional views are user specific.
Utilization
This view shows the resource assignments used within the project and their utilization.
Edit
Shows the view editing dialog. Both the built-in and custom views are listed. You can
create custom views by clicking the plus icon.

Report
This option lets you prepare and report the project content graphically. You can choose
between built-in and custom reports.
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Earned Value Analysis
Creates a graphical report of the earned value analysis. In the Inspector you can define
additional report options.
Standard Report
Creates a graphical report. In the Inspector you can define additional report options.
Edit
Shows the report editing dialog. Both the built-in and custom reports are listed. You can
create custom reports by clicking the plus icon.

Attachments
This option lets you view and edit attachments used within the project.
All
Shows the view displaying all project attachments.
Check lists
Shows the view displaying all project checklists.
Files
Shows the view displaying all project files.
Events
Shows the view displaying all project events.
Information
Shows the view displaying all project information.
Issues
Shows the view displaying all project issues.
Risks
Shows the view displaying all project risks.
Edit
Shows the dialog for editing the attachment views. Both the built-in and custom
attachments are listed. You can create custom attachment views by clicking the plus icon.
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Filters
Shows the Inspector with built-in filters. You can create custom filters by clicking the plus
icon. Search filters are ideal for adjusting the display of project content.

View Options
Shows the Inspector with the display options for the current view. These options help you
adjust how project content is displayed in the particular view.

Details
This menu option contains the various views, view options, and styles that are available.

Zoom
This menu option contains options for zooming in and out of project content and the
particular views.
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Zoom In
Zooms into the project content in the current view.
Zoom Out
Zooms out of the project content in the current view.
Default Size
Displays the project content at the default size in the current view.
Fit in View
Adjusts the size of the content to fit the current view.
Percent
Contains a selection of built-in zoom levels (in percent) to display the current content.

Time Scale
This menu option contains options for adjusting the time scale in the particular view.
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Zoom In
Zooms into the time scale in the current view. This option only works with views with a time
scale.
Zoom Out
Zooms out of the time scale in the current view. This option only works with views with a
time scale.
Fit Project
Automatically fits the time scale to suit the project length. The entire project will be shown
in the visible section of the time scale.
Fit Selection
Automatically fits the time scale to suit the selection. The selection will be shown in the
visible section of the time scale.

Show Critical Path
Shows a graphical display in the bar chart for the critical path. The critical path shows all
activities which affect the project deadline.

Hide/Show Toolbar
Hides/shows the toolbar in the program window.

Customize Toolbar
Opens the dialog to adjust the toolbar and add favourites.
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Window
This menu contains options for handling program windows.

Since macOS Sierra this menu contains additional options for using tabs.

Minimize
Minimizes the active program window to the dock. Same action as clicking the center
(yellow) traffic light button on the top left of the window.

Minimize All
Minimizes all open program windows to the dock. Same action as clicking the center
(yellow) traffic light button on the top left of the window while keeping the alt key held
depressed.
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Zoom
Zooms the program window to fit its content. Same action as clicking the right (green)
traffic light button on the top left of the window.

New Window
Opens an additional window of the current program file.



The tabs and 'merging all windows' options are available in macOS 10.12
Sierra or newer.

Show Previous Tab
Goes to the previous tab.

Show Next Tab
Goes to the next tab.

Move Tab to New Window
Moves a tab to a separate window.

Merge All Windows
When you open multiple projects or project windows, you can merge them into one
window that contains multiple tabs. This enables the tab options.

Enter/Exit Full Screen
Activates/deactivates full screen mode for the active program window. The program will
zoom to fill the entire screen.

Bring All to Front
Brings all open program windows to the front.

Window Configurations
Contains window configurations. You can create these and use them for additional
projects.
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Edit
Opens the window to edit window configurations.

Hide/Show Inspector
Hides/shows the Inspector in the active program window.

Show/Hide Detail View
Shows/hides the detail view in the active program window.

Show/Hide Library
Shows/hides the library.
Library
The »Library« icon opens and closes the »Library« window. This lets you manage and
store assorted project information and content as well as use it again for later projects.
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The Library is a separate window which manages content across the project. You will find
a search box on the upper edge of the window. This lets you find content quickly. Below
this you will find a list of content including:
• Attachments
• Documents
• Contacts
• Outlook contacts
• Activities
If you select one of these folders, further divisions appear on the right-hand side of the
list.



If you created content in Merlin 2, Merlin Project will notify you. This lets
you include the content from the Merlin 2 library.

Below this is the Content list which is populated with content from the category you
selected.
Use your mouse to drag content from and to the Library. If you "drag & drop" content to
the Library, it will appear under one of the mentioned points.
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The Contacts and Outlook contacts folders are populated automatically
with addresses using content from the programs »Contacts« and
»Outlook«.

You will find the gear icon on the bottom right-hand edge of the window. Click it and a
context menu will appear containing further options for using the Library. The gear icon is
context sensitive which means different options are displayed depending on your
selection.

Among other options, you can use the gear icon to create new folders in the Library for the
particular categories and access the Library preferences. Additionally, you can open
selected documents directly using a compatible program.
Attachments

The Attachments folder contains:
• All Items
• Own Items
• Standard Attachments
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The All Items folder lists all attachments in the Library.
The Own Items folder contains attachments defined by the user.
The Standard Attachments folder includes the attachments built into Merlin Project.
Documents

The Documents folder contains three folders for storing and using documents belonging
or useful to the project.
• All Items
• Own Items
• V-Modell XT
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The All Items folder lists all documents in the Library.
The Own Items folder contains documents added by the user. These can be of any file
type.
The V-Model XT folder includes »V-Model XT« documents.



The V-model is used to regulate the software development process
within the German federal administration. It encompasses the
procedure, methods to be applied, and functional requirements for tools
to be applied. [Source: Wikipedia.com]

Contacts

The Contacts folder contains content from the Contacts.app. This gives you direct access
in the Library to your addresses in the Contacts.app and lets you use them to create
assignments/resources.
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If you drag an address book entry from the Contacts list to an object in
Merlin, this entry will be created as an assignment/resource in the
current project.

You can activate/deactivate the address books under the »Address books« tab under
»Preferences > Library«. Additionally, you can also configure LDAP servers there.

When opening Merlin Project and the Library, the system will prompt you for permission to
access your contacts. You should grant this otherwise your contact will not be displayed in
the Library under Contacts.
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Access to the »Contacts« app must be granted by the user in OS X so
they appear in the Library. You can grant this manually later on by
activating the checkbox for Merlin Project under »System Preferences >
Security & Privacy« under the »Privacy« tab for Contacts. You will then
need to restart Merlin Project.

LDAP

If you have set up and enabled LDAP servers under Preferences > Library, you will be able
to select them in the Library.
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LDAP entries do not appear automatically; they are only filtered once you
have entered search terms. If an entry exists on the LDAP server, the
search hit will be displayed in the Library.

Outlook contacts

The Outlook contacts folder contains address book entries from the Outlook.app (part of
Microsoft Office). This gives you direct access in the Library to your addresses in the
Outlook.app and lets you use them to create assignments/resources.
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If you drag an address book entry from the Outlook contacts list to an
object in Merlin Project, this entry will be created as an
assignment/resource in the current project.

You can activate/deactivate the address books under the tab of the same name under
»Preferences > Library«. Additionally, you can also configure an LDAP server there.
Activities

By default, the Activities folder contains two folders: activity outlines and groups. This lets
you build modular projects comprising various phases/groups/activities. Use your mouse
to drag such activities from and to the Library.
• All Items
• Own Items

The All Items folder contains all activities/groups
The Own Items folder contains activities/groups stored by the user in the Library.
The Activities folder lets you store frequently used content for various projects in the
Library and allows you to integrate it at a later date and when required into one or more
projects.
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Drag the »Project start« from the Library to the outline of a new project. The content will
then be included automatically in the new project.

Show/Hide Resources Window
Shows/hides the resources window in the active program window.

Show/Hide Warnings
Shows/hides warnings in the active program window.
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Help
This menu helps answer questions about the program.



In OS X all help menus have a built-in search function. When you type a
search term, the search results are divided into Menu Items and Help
Topics. If you select a menu item that has been found, a blue arrow
hovers over where you can find the menu item in the program.

Merlin Project Help
Opens the help function.

Merlin Project Tutorials
Opens the tutorials with information on how to use the product.

Merlin Project on the Web
Further product information on the Web.

Create Support Profile
Creates a support profile which is helpful to the support team when fixing the issue.
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Inspectors
Each Inspector contains fields with different options and assorted information. In many
fields, you can enter values for your selection in the work area. In the Outline, you can also
show and use these fields as columns.
The Inspectors are divided into tabs which, in turn, contain additional options. Depending
on the selection, you always have the right Inspectors at hand when using Merlin Project.
Each Inspector is listed together with its name.

Inspector »Project Settings«
When creating a new project, the inspector New Project will be displayed. It contains
Settings for the project. Merlin Project offers various options relevant for projects. By
clicking on the »Settings« icon in the icon bar, you can show the inspector whenever you
need it.
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Following you will find the individual tabs in the New Project inspector:

General
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Inspector »Project Settings«

The inspector New Project: General contains options for setting up project presets.
Date Presets
These are presets for the planning Direction of the project, the Start Date and the first
Week Day. These directly affect the project’s date presets.
Work
Here you can define presets for Work in the project. These can be entered for the
following options:
• Hours per man-day
• Hours per man-week
• Days per man-month
• Default Value
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The Standard Value defines the number of time unites for new activities. The question
mark indicates whether this is an estimated value or not. It does not affect project planning
and may be omitted if desired.
Merlin Project will calculate all durations taking into account these values. The values
shown here are default presets and can be changed any time.



Work units directly affect calculated values. When an activity is planned
with 20 Days of planned work, the corresponding planned Duration is
one month. This is because one man month is per default set to 20 work
days in a project.

Duration
Here you can define a Default Value for the duration of new activities. This is the duration
value used automatically when adding new activities.
The Calculation Unit for duration is set to Dynamically per default. This means that Merlin
Project will automatically convert a duration of 7 Days into 1 Week, etc.
If this is not desired, you can select a fixed unit from the drop-down menu. This will make
all durations show using the selected unit.
Status Date
The Status Date option will move those activities not yet started to the defined status date.
This enables dynamic postponement of scheduled activities in a project. Dynamic Planning
offers two options on which activities shall be moved to the status date. The expected and
planned values are vital for this operation. They directly affect the project’s date presets.
• Expected & planned values
• Only expected values



Only expected values will move activities only to the current date.
Planned values – shown with a grey bar in the Gantt chart – remain as
they are. These are mainly starting dates of the parent group or the
complete project.

Granularity defines the time unit pattern for moving activities.
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Resources
Here you can edit two options for resources: the style of the used Initials for the
resources, and whether multiple assigned resources will share their work on an activity.
When deactivating the Share their work option, resources will no longer be assigned
evenly on the work for an activity.



Per default, resources share their work in activities. Two assigned
resources in that case would be able to perform a day’s work load within
half a day. If you want to deactivate this option, simply remove the check
mark.

Advanced Options
The inspector New Project: General* offers further options for edting _Currency Symbols
and Visibility of the project. The latter option will hide the project from anonymous users.
Only those resources defined in the project as a user will be able to see this project.

Calendar

The inspector New Project: Calendar contains options for setting up project presets. The
calendars can also be used as project calendars.
You will also find the work calendar settings for regular working times and expections for
vacation or non-regular working times in this inspector.
• Regular Week
• Exceptions
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Use the mouse to define the working times for each day individually. Select multiple days
to adjust working times in one pass.



By clicking on the Gear icon you export and import working times in ICS
calendar file format.

Codes

The inspector New Project: Codes offers options creating and editing codes. These
codes can be used in the project to define the project structure. There are special columns
available for codes, and these can be displayed in the outline view.
• Outline Codes
Clicking on + will create a new outline code, and clicking on - will delete the selected
existing outline code. Every code item can be assigned with a Prefix, Sequence, Min.
Length and Separator. You can view your settings directly in the preview.
• WBS Codes
Clicking on + will create a new WBS code, and clicking on - will delete the selected
existing WBS code. Every code item can be assigned with a Prefix, Sequence, Min. Length
and Separator. You can view your settings directly in the preview.
There are two further options for WBS codes. One creates a code for new activities, the
other tests the uniqueness of new codes. You can deactive both options by unmarking the
appropriate checkbox.



WBS is an acronym for Work Breakdown Structure and can be used for
project structure numbering.

Value Lists
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The inspector New Project: Value Lists contains options for editing and creating value
lists.
These are used for attachments, costs and resources. The values will show in the
inspector for the corresponding attachments, costs and resources. Each attachment type
has its own customizable value list. Simply select the existing attachment from the For
drop-down menu to show the relevant value list.
• File
• Event
• Information
• Costs
• Issue
• Resources
• Risk
Using the »+« and »-« icons you can create or delete values in the selected list. Some
values offer to define an icon. The newly created values will be immediately available in the
inspector for the corresponding attachment type.

Utilization
The inspector New Project: Utilization contains options for resource utilization in a
project. It is divided into two main options.
• Utilization Thresholds
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Here you can define two values for Over-utilization and Under-utilization thresholds in
percent for the project. This affects the displayed utilization for ressources assigned to
this project.
• Resource Leveling
These are the option for resource leveling:
• For
• Overutilization interval
• Clear former delays
• Within Slack only
• Leveling Order
• Level Now

In the For drop-down menu you can define whether Resource Leveling shall be aplied to
the complete Project or to a time period From - To.
The Overutilization interval determines the time units for resource leveling. You can
choose between any of the available time units.
The Clear former delays option deletes delays caused by over-utilization. This option is
activated by default.
The option Within Slack only will limit resource leveling to within the slack defined in
project planning.
The option Leveling Order enables you to determine the sequence of resource leveling for
the project or time period.
• Default
• Priority
• # (manual sorting)
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Clicking on the »Level Now» button will apply the above options. The same options are
available in the »Edit > Resource Leveling« menu.
Level Now offers the following options:
• Level All
• Reset All
• Level Selection
• Reset Selection



Leveling order options are used with the following criteria:

• Default
◦ Predecessor relationship
◦ Constraints
◦ Available slack
◦ Priority (lowest priority will be shifted first)
◦ Duration (longer duration will be shifted before shorter duration)
◦ The manual order by #-numbers (activities with higher numbers will be
shifted first)
• Priority
◦ Priority (lowest priority will be shifted first)
◦ Predecessor relationship
◦ Constraints
◦ Available slack
◦ Duration (longer duration will be shifted before shorter duration)
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◦ The manual order by #-numbers (activities with higher numbers will be
shifted first)
• # (manual sorting)
◦ The manual order by #-numbers (activities with higher numbers will be
shifted first)
◦ Priority (lowest priority will be shifted first)
◦ Predecessor relationship
◦ Constraints
◦ Available slack
◦ Duration (longer duration will be shifted before shorter duration)
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Inspector »Activity«
This inspector includes those settings related to the majority of the work in a project.
When selecting a project, one or more activities/milestones, the Activity: Plan inspector
will show to help you in your planning work.

Inspector »Activity: Plan«
This inspector shows – depending on the current selection – either the planning values for
the project or for the selected activities/milestones.
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Title
The »Title« section contains three options for naming of the selected object.
• Title
• Subtitle
• Additional Title
The Title lets you enter a designation for the project, activities and milestones.
Subtitle und Additional Title are optional values. You may use them for more details on the
designation.
Work
The »Work« section contains four options for the definition of the selection’s work and
duration. Activities and milestones also offer a checkbox for conversion into a
milestone/activity.
• Work
• Overtime Work
• Duration
• Milestone
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New activities will automatically have the Work value of »1 day ?«. You can change this
value in the project settings for new activities. You can enter the required work manually.
To do this, you will need to enter a digit and a unit. When entering »10 W«, this will
automatically be converted into »10 Weeks«.
This value will plan ten weeks of work for this activity. It determines the work required to
finish this activity. A question mark indicates that work load for this activity is an estimated
value. That does not affect the project calculation.
In the field Overtime Work you can set the duration of the work that will be performed
outside the project’s working times. The planned costs of the activity will then also be
affected by the overtime rate of the standard/assigned resource.
In the Duration field you can determine the duration related to the work times in the
project and the duration related to consecutive time.



Time Units
Merlin Project offers various time units for Work, Duration and
Consecutive Duration to be entered in the Work and Duration fields.
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Inspector »Activity«



You can enter various units and you don’t have to fully type them. You
can enter any English time unit. When entering »2 d« into the Work or
Duration field, this will be converted into »2 days«. So the »d« is the
short form for »day«. The duration is affected by the working times
entered for a project. When working times of 8 hours per day are
defined in the project, one day consists of 9 consecutive hours (8
working hours plus one hour lunch break). For consecutive duration,
enter an »e« as a prefix for “elapsed”. Entering »2 ed« will therefore
convert into a duration of »2 edays«. This means the activity will take
exactly 2 x 24 hours.

Start, End and Alignment
Further options are available for setting the Start, End and Alignment of the selection.
In projects, the Start option is a starting date. Activities however have an unrestricted start
per default. This means, the start date for activities will be controlled dynamically by the
planning for the parent group or by links with other activities.
The drop-down menu offers further options for the definition of start dates. These are:
• Precise
• Earliest
• Latest
• Between
The value »Precise« defines a precise start date for the selection. An entry field will be
displayed in which you can enter a date including time for the start. If the option »Fixed
precise start date« is checked in the calendar, the activity is fixed at the specified date
and therefore static. The fixed date will be marked with an exclamation mark. This activity
will not be affected by any other dependencies. This is handy for fixed events.
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The Alignment option offers various options for the start date. These are:



You can enter date fields manually. Do so using the left and right arrow
keys to switch between the individual units (day, month, year, hour and
minutes). Use the up and down arrows to change the values. Clicking
on the calendar icon will show the calendar window in which you will be
able to select dates with a simple mouse click.

The value »Earliest« defines an earliest start date for the selection. An entry field will be
displayed in which you can enter a date including time for the earliest start. When marking
the option »Fixed« the activity start will be fixed to the entered date. This activity will not
be affected by any other dependencies. This is handy for fixed events.
This is handy for fixed events. The value »Latest« defines a latest possible start date for
the selection. When marking the option »Fixed« the activity start will be fixed to the
entered date. This activity will not be affected by any other dependencies. This is handy
for fixed events.
This is handy for fixed events. The »Between« option combines the »Earliest« and
»Latest« options to allow for a slack of the selection. This is quite useful for flexible
project planning.
You can adjust the Alignment for the Earliest and Latest values. By selecting one of the
three options Earliest, Latest or Long, the selection will be aligned according to the parent
group. The alignment Earliest is active by default. This means activities always start as
early as possible and are affected by the working times and other dependencies used in
the project. The opposite to this is the alignment Latest. When selected, activities start as
late as possible. The alignment Long aligns the activity with the maximum length of the
parent structure (the parent group or the entire project) and so is a mixture of Earliest and
Latest.
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All options for Start are also available for the Finish of a selection. This
lets you define the end date for the selection.

Advanced

The »Advanced« section contains further options for work.
• Resource Units
• Priority
• Leveling Delay
• Calendar
• Precedence
The Resource Units option defines the percentage value for utilization related to work and
completion. The value 100% will be used per default. When a resource has been assigned
to the activity the value in this field will be greyed out and cannot be changed. When
removing all assignments, this option can be changed.
You can enter the Leveling Delay with a time unit. This will move the activity into the future
by the entered time period.
The Priority option defines the priority for resource leveling. The higher the priority in
points, the more preferential this activity will be treated in resource leveling.
The Calendar option lets you define a different calendar for the selection from the dropdown menu. Merlin Project provides built-in calendars by default. You can add custom
calendars in »Project Settings« in the »Calendar« tab.
The Precedence option defines which calendar shall be used as the main calendar for the
selection. Here, the calendar of the assigned resource will be preferred by default.
The »Expected« section shows the expected values and the values calculated by Merlin
Project for the selection. These values are determined by all dependencies affecting the
selection and the current calendar’s settings.
• Status
• Start
• End
• Work
• Duration (consecutive)
• Utilization
The »Status« view shows the completion value for the selection. This can be either
Upcoming, On time (green dot), Slightly Behind Schedule (yellow triangle), Behind
schedule (red rectangle) or Completed. It depends on the current state of the actual

| Handbook for Merlin Project 4

137

values and the current date. This information will be shown in the corresponding column of
the work area outline.
The »Start« view shows the calculated value for the expected start date of the selection.
The »End« view shows the calculated value for the expected end date of the selection.
The »Work« view shows the calculated value for the expected work of the selection.
The »Duration« view shows the calculated value for the expected duration and the
expected elapsed duration (in parenthesis) of the selection.
The »Utilization« view shows the calculated value for the expected utilization of the
selection (in percent.

Inspector »Activity: Dependencies«
This inspector controls the Dependencies between the individual activities. When
selecting an activity, the predecessors and successors as well as the Sequence of
dependencies and an optional Slack Duration will be displayed.

Predecessors and successors share identical lists. These are separated into the following
columns:
# * Title * Type * Lead/Lag
The # column contains the number of the predecessor/successor.
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The Title column contains the title of the predecessor/successor.
The Type column contains the dependency type (FS, SS, FF, SF) between the selection
and the predecessor/successor.
The Lead/Lag column contains the slack between the dependencies. Here you can define
a duration in case the activities are not to start/end immediately with/after the
predecessor/successor.



By double clicking on the row the corresponding activity will be
displayed in the main window.

Inspector »Activity: Finance«
This inspector is divided into the »Budget«, »Cost« and »Balance« tabs. Here you can
determine and control the costs for the selection.
Budget
The »Budget« tab is divided as follows.
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Requested
In the »Requested« section you can enter requested budgets for the selection. Enter the
sum for the requested budget into the Amount field. Optionally add the person requesting
the budget into the By Resource field, or select it from the resources available in the
project.
Approved
In the »Approved« section you can enter approved budgets for the selection. Enter the
sum for the approved budget into the Amount field. Optionally add the person approving
the budget into the By Resource field, or select it from the resources available in the
project.
Status
In the »Status« section you can define the following options for the budget status.
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• No Budget
• Requested
• Approved
• Rejected
The Date: option offers you to enter a date for the status.
Results
Here you can view the results for the budget. These are divided into Approved, Distributed
and Undistributed.
In the Notes section you may add notes for budget documentation.
Cost
The »Cost« tab is divided as follows.

Base Costs
Base costs are any further costs for a selection. In the Accrual field you can enter the cost
accrual via a drop-down menu.
Clicking on the »+« icon will create a new cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains the following columns for editing:
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• Title
• Planned Amount
• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status
• Added by
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.
Balance
The »Balance« tab is divided as follows.
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Expected Costs
The »Expected Costs« section contains a list of expected costs for the selection. These
costs are divided into:
• Base Costs
• Work Costs
• Attachment Costs
and the resulting Balance.
The Base Costs contain the sum of all expected base costs for the selection.
The Work Costs contain the sum of all expected work costs for the selection. The work
costs are those costs for the assigned resources.
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The Attachment Costs contain the sum of all expected costs for the selection’s
attachments. The attachment costs arise from costs for attachments.
Planned Costs
The »Planned Costs« section contains a list of planned costs for the selection. These
costs are divided into:
• Base Costs
• Work Costs
• Attachment Costs
and the resulting Balance.
The Base Costs contain the sum of all planned base costs for the selection.
The Work Costs contain the sum of all planned work costs for the selection. The work
costs are those costs for the assigned resources.
The Attachment Costs contain the sum of all planned costs for the selection’s
attachments. The attachment costs arise from costs for attachments.
Actual Costs
The »Actual Costs« section contains a list of true costs for the selection. These costs are
divided into:
• Base Costs
• Work Costs
• Attachment Costs
and the resulting Balance.
The Base Costs contain the sum of all actual base costs for the selection.
The Work Costs contain the sum of all actual work costs for the selection. The work costs
are those costs for the assigned resources.
The Attachment Costs contain the sum of all actual costs for the selection’s attachments.
The attachment costs arise from costs for attachments.

Inspector »Activity: Actual Values«
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In the Inspector »Activity: Actual Values« you can enter and control the project’s actual
values.



Actual values are the true values to be entered in the course of the
project. As such, they are the actual values, and not the planned or
expected values, in the project.

Actual Start
You can enter the actual start date for the selection into this field. This value corresponds
to the actual start date.
Actual End
You can enter the actual end date for the selection into this field. This value corresponds
to the actual end date.
% completed
You can enter the actual completion value in percent into this field. This value corresponds
to the actual completion state.
As a result from the entered % complete you will get:
• Actual Work
• Remaining Work
in absolute numbers.
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Actual Work
This section contains options for the actual work. Here you can enter and control the
values for any work to be performed. You can enter the value for the work actually
performed into the Actual Work field. Advanced options for this section are:
• Actual Overtime Work
• Remaining Work
• Reported on
Actual Overtime Work
You can enter the value for overtime work actually performed in the Actual Overtime Work
field.



only needed if it does not match the planned overtime work value.

Remaining Work
The option Remaining Work allows you to enter the value for the remaining work to be
performed.
Reported on
The option Reported on allows you to enter a date for the entry of the actual values.
Results
This section shows the results for the actual values of the selection.
The Remaining Duration contains the value for the duration remaining in the selection.
Completed through shows the current time point of work in progress based on the current
amount of completion or actual work.
Expected
This section contains the expected values for the selection.
• Start
• End
• Work
• Duration (consecutive)
• Utilization
The »Start« view shows the calculated value for the expected start date of the selection.
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The »End« view shows the calculated value for the expected end date of the selection.
The »Work« view shows the calculated value for the expected work of the selection.
The »Duration« view shows the calculated value for the expected duration and the
expected elapsed duration (in parenthesis) of the selection.
The »Utilization« view shows the calculated value for the expected utilization of the
selection (in percent.
Planned
This section contains the currently planned values for the selection.
• Start
• End
• Work
• Duration (consecutive)
The »Start« view shows the value for the planned start date of the selection.
The »End« view shows the value for the planned end date of the selection.
The »Work« view shows the value for the planned amount of work for the selection.
The »Duration« view shows the value for the planned duration and the planned elapsed
duration (in parenthesis) of the selection.

Inspector »Activity: User-defined«
The Inspector »Activity: User-defined« is divided into:
• Tags
• Fields
Here you can create and control custom Tags and Fields for the project.
Tags
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The Tags tab contains a built-in list with tags. You can expand this list using custom tags.
Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will delete the
selected existing tag. When activating the Assigned check box, the corresponding tag will
be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields

Clicking on the »+« or »-« icon the in Fields tab will create new or delete existing fields for
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custom columns. The columns may contain any values and various format options. E.g.:
• Text
• Number
• Date
• Duration
• Checkbox
• Attention level
• Media

Inspector »Column: Notes«

In the Inspector »Column: Notes« you can enter any information as formatted text. You
can expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document information for later use in
this inspector.
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Inspector »Dependency«
After having created activities in a project you can link these activities. Upon linking
activities, dependencies will be created. In the menu »Structure > Link« you can define
dependencies for multiple (at least two) selected activities, milestones, groups or
assignments.
On the icon bar you will find the »Link« button. It provides the same options as the
corresponding menu.

When selecting a dependency in the work area, the »Dependency« inspector will be
displayed. The provided options offer settings for the dependency between the linked
objects (activities, groups, milestones and assignments).



You can select a link in the menu »Structure > Link«. Using the shortcut
[ctrl + cmd+ L] you can quickly create the »Finish to Start«
dependency for the selected activities (at least two).

Ill.: A dependency selected in the work area (Gantt).
Following you will find the individual options in the Dependency inspector:

Predecessors
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In the »Predecessors« section you will find information on the predecessor for the
dependency. By clicking on the arrow button you will automatically be directed to the
predecessor.
The Activity # # option contains the consecutive number (#) of the predecessor in the
selected dependency.
The Title option contains the designation of the predecessor in the selected dependency.

Successor
In the »Successor« section you will find information on the succesor for the dependency.
By clicking on the arrow button you will automatically be directed to the successor.
The Activity # # option contains the consecutive number (#) of the successor in the
selected dependency.
The Title option contains the designation of the successor in the selected dependency.
Advanced Options
Furthermore you will find the following options in the inspector:
• Type
• Slack Duration
• Expected Critical
• Planned Critical
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Type

The Type option offers a drop-down menu with four dependency options. Here you can
define the order of dependency between predecessor and successor.
• Finish to Start (the predecessor ends and the successor starts)
• Start to Start (the predecessor and the successor start simultaneously)
• Finish to Finish (the predecessor and the successor end simultaneously)
• Start to Finish (the predecessor starts and the successor ends)
The Finish to Start dependency is the most commonly used dependency type between
activities and serves as the basis for the waterfall method in project management.
Slack Duration

Using the Slack Duration option you can define a positive or negative duration for the
dependency. This leads to the effect that a successor must start later or earlier by the
entered slack value.
When entering a slack duration of »- 1 Day«, the successor will start one day earlier. When
entering a slack duration of »2 Days«, the successor will start two days later.
Expected Critical

The Expected Critical option contains information on the Critical Path of the dependency
in relation to the expected values. This option offers two values.
• »Yes« the dependencies will lead to a critical path when considering the
expected values
• »No« the dependencies will not lead to a critical path when considering the
expected values



The Critical Path will always be valid when the dependencies
compromise on the timely completion of a project after changes have
been made.

Planned Critical

The Planned Critical option contains information on the Critical Path of the dependency in
relation to the planned values. This option offers two values.
• »Yes« the dependencies will lead to a critical path when considering the planned
values
• »No« the dependencies will not lead to a critical path when considering the
planned values
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Inspector »Resource«
In this inspector you can edit the project’s resources.

In the work area’s Resource view you can select the resources added to this project. This
will open the Resource inspector. It contains Settings for the selected resources. Merlin
Project therefore offers various options relevant for editing resources.
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Following you will find the individual tabs found in the Resource inspector:

Inspector »Resource: Info«
The inspector Resource: Info provides options for editing information on the selected
resource.
Title
This is the Title or designation of the resource. You can enter four designation types for
each resource:
• Title
• Subtitle
• Additional Title
• Initials



The initials will be created automatically from the Title and can be
changed in the project settings.

Advanced Options
In the Inspector:Info you will also find the following options for a selected resource:
• Phone
• Email
• Role
• Type
• Available Units
• Is user
• Permissions
• Status
Phone contains the resource’s telephone number. Clicking on the »Telephone icon« will
read the number.
Email contains the resource’s email address. Clicking on the »@« icon will open a new
email window of the default email application. Now you can immediately send an email to
the resource.
Role contains the resource’s role in the project. Clicking on the »Arrow« icon will expand
the menu with a couple of pre-defined roles.
Type contains the selection for the following resource types:
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• Person
• Material
• Company
• Equipment
Available Units contains the available units for resource utilization.
Is User converts a resource into a user including password and user name.
You can define three types of permissions:
• Read & Write (resource has all permissions)
• Read-only (no write permissions)
• No Access (no permissions and no visibility)
Status contains the resource’s utilization status. This can be:
• Well utilized (green circle)
• Under-utilized (yellow triangle)
• Over-utilized (red rectangle)

Inspector »Resource: Calendar«

The inspector Resource: Calendar contains calendar configuration options for the
selected resource. The calendar uses the project calendar settings as standard.
You will also find the work calendar settings for regular working times and exceptions for
vacation or non-regular working times in this inspector.
• Regular Week
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• Exceptions
Use the mouse to define the working times for each day individually. Select multiple days
to adjust working times in one pass.

The Exceptions area contains options for adding new exceptions. Click on the + icon to
create a new exception.
Adding work intervals will change the non-working exception into a working exception.
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The Gear icon contains options for the resource calendar:
• Reset to Base Values
• Reset All Days to Base Values
• Import Resource Calendar
• Export Resource Calendar



Clicking on the Gear icon lets you export and import working times in the
ICS calendar file format.

Inspector »Resource: Costs«
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The Standard Rate contains the actual costs for the resource.

The Overtime Rate contains the actual costs for the resource’s overtime work.
The Base Costs contain further costs generated by the resource.
The Intended Purpose defines whether the base costs apply per project or per
assignment.
The Accrual contains a list of possible accruals.
• Accrue prorated
• Accrue immediately
• Accrue at start
• Accrue at end
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Clicking on »+« will create a new base cost, and clicking on »-« will delete the selected
existing base cost. The Title column allows you to designate the base cost.
The Billable checkbox indicates the cost is billable.
Further options for the costs information can be:
• Type
• Account
• Status
• Added by
Inspector »Resource: Actual Values«

In the inspector *Resource: Actual Values« you can enter and control the resource’s actual
values.



Actual values are the true values to be entered in the course of the
project. For resources, these are calculated values.

Actual Start
This field shows the actual start date for the selection. This value corresponds to the true
start.
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Actual End
This field shows the actual end date for the selection. This value corresponds to the true
end.
% completed
This field shows the actual completion value in percent. This value corresponds to the true
completion state.

Actual Work
This section contains options for the actual work. Here you can enter and control the
values for any work to be performed. The Actual Work option shows the value for the work
actually performed. Advanced options for this section are:
• Actual Overtime Work
• Remaining Work
• Reported on
Actual Overtime Work
The Actual Overtime Work option shows the value for the overtime (more than planned)
work actually performed.
Remaining Work
The option Remaining Work shows the value for the remaining work to be performed.
Reported on
The option Reported on shows the date of entry of the actual values.
Results
This section shows the results for the actual values of the selection.
The Remaining Duration contains the value for the duration remaining in the selection.
Completed through shows the completion status for the current date.
Expected
This section contains the expected values for the selection.
• Start
• End
• Work
• Overtime Work
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• Duration (consecutive)
• Utilization
The »Start« view shows the calculated value for the expected start date of the selection.
The »End« view shows the calculated value for the expected end date of the selection.
The »Work« view shows the calculated value for the expected work of the selection.
The »Duration« view shows the calculated value for the expected duration and the
expected elapsed duration (in parenthesis) of the selection.
The »Utilization« view shows the calculated value for the expected utilization of the
selection (in percent.
Planned
This section contains the currently planned values for the resource.
• Start
• End
• Work
• Duration (consecutive)
• Utilization
The »Start« view shows the value for the planned start date of the selection.
The »End« view shows the value for the planned end date of the selection.
The »Work« view shows the value for the planned amount of work for the selection.
The »Duration« view shows the value for the planned duration and the planned elapsed
duration (in parenthesis) of the selection.
The »Utilization« view contains the planned utilization value (in percent) for the resource.

Inspector »Resource: User-defined«
The inspector *Resource: User-defined« is divided into two tabs.
• Tags
• Fields
Here you can create and control custom Tags and Fields for resources within the project.

Tags
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The Tags tab contains a built-in list with tags. You can expand this list by adding custom
tags. Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will
delete the selected existing tag. When activating the Assigned check box, the
corresponding tag will be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields

In the Fields tab you can create new fields for custom columns. These columns may
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contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »Resource: Notes«

In the inspector *Resource: Notes« you can enter any information as formatted text. You
can expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document information for later use in
this inspector.
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Inspector »Assignment«
You can use the inspector to edit resources assigned to a project.

Inspector »Assignment: Plan«
When assigning a resource to a project’s activity it can be selected in the work area. With
the Inspector »Assignment: Plan« Merlin Project offers various options relevant for such
assignment.
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Resource
The Resource option contains the assigned resource’s name and a drop-down menu that
lets you assign the resources included in the project. By clicking on the arrow button you
will be directed to the resource view.

Work
The Work option contains the entry field for the work to be performed by the activitiy’s
assigned resource. You can enter this value either in percent or as a total value.
Further option in the Work section are:
• Overtime Work
• Duration
• Start
• End
• Alignment

Advanced
The »Advanced« section contains further options for work.
• Start/Finish
• Calendar
• Precedence
• Priority
• Resource Units
• Leveling Delay
The Calendar option lets you select a different calendar for the selection from the dropdown menu. Merlin Project provides built-in calendars by default. You can add custom
calendars in »Project Settings« in the »Calendar« tab.
The Precedence option defines which calendar shall be used as the main calendar for the
selection.
The Priority option defines the priority for resource leveling. The higher the priority in
points, the more preferential this activity will be treated in resource leveling.
The Resource Units option defines the percentage value for utilization related to work and
completion. The value 100% will be used per default. When a resource has been assigned
to the activity the value in this field will be greyed out and cannot be changed. When
removing all assignments, this option can be changed.
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You can enter the Leveling Delay with a time unit. This will move the activity into the future
by the entered time period.

Expected
The »Expected« section shows the expected values and the values calculated by Merlin
Project for the selection. These values are determined by all dependencies affecting the
selection and the current calendar’s settings.
• Status
• Start
• End
• Work
• Duration (consecutive)
• Utilization
The »Status« view shows the completion value for the selection. This can be either
Upcoming, On time (green dot), Slightly Behind Schedule (yellow triangle), Behind
schedule (red rectangle) or Completed. It depends on the current state of the actual
values and the current date. This information will be shown in the corresponding column of
the work area outline.
The »Start« view shows the calculated value for the expected start date of the selection.
The »End« view shows the calculated value for the expected end date of the selection.
The »Work« view shows the calculated value for the expected work of the selection.
The »Duration« view shows the calculated value for the expected duration and the
expected elapsed duration (in parenthesis) of the selection.
The »Utilization« view shows the calculated value for the expected utilization of the
selection (in percent.

Inspector »Assignment: Dependencies«
This inspector shows the Dependencies between the individual assignments. When
selecting an assignment, the predecessors and successors as well as the Sequence of
dependencies and an optional Slack Duration will be displayed.
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Predecessors and successors share identical lists. These are separated into the following
columns:
# * Title * Type * Slack Duration
The # column contains the number of the predecessor/successor.
The Title column contains the title of the predecessor/successor.
The Type column contains the dependency type (FS, SS, FF, SF) between the selection
and the predecessor/successor.
The Slack Duration column contains the slack between the dependencies. Here you can
define a duration in case the activities shall not start/end immediately with/after the
predecessor/successor.

Inspector »Assignment: Finance«
This inspector is divided into the »Budget«, »Costs« and »Balance« tabs. Here you can
determine and control the costs for the selection.

Budget
The »Budget« tab is divided as follows.
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Requested
In the »Requested« section you can enter requested budgets for the selection. Enter the
sum for the requested budget into the Amount field. Optionally add the person requesting
the budget into the By Resource field, or select it from the resources available in the
project.
Approved
In the »Approved« section you can enter approved budgets for the selection. Enter the
sum for the approved budget into the Amount field. Optionally add the person approving
the budget into the By Resource field, or select it from the resources available in the
project.
The Amount option contains the approved costs for the budget.
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The By Resource option contains the budget-approving person.
Status
In the »Status« section you can define the following options for the budget status.
• No Budget
• Requested
• Approved
• Rejected
The Date: option offers you to enter a date for the status.
Results
Here you can view the results for the budget. These are divided into Approved, Distributed
and Undistributed.
In the Notes section you may add notes for budget documentation.

Costs
The »Costs« tab is divided as follows.
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Base Costs
Base costs are any further costs for a selection. In the Accrual field you can enter the cost
accrual via a drop-down menu.
Clicking on the »+« icon will create a new cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains teh following columns for editing:
• Title
• Planned Amount
• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status
• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.
Balance
The »Balance« tab is divided as follows.

170

Inspector »Assignment«

Expected Costs
The »Expected Costs« section contains a list of expected costs for the selection. These
costs are divided into:
• Base Costs
• Work Costs
• Attachment Costs
and the resulting Balance.
The Base Costs contain the sum of all expected base costs for the selection.

| Handbook for Merlin Project 4

171

The Work Costs contain the sum of all expected work costs for the selection. The work
costs are those costs for the assigned resources.
The Attachment Costs contain the sum of all expected costs for the selection’s
attachments. The attachment costs arise from costs for attachments.
Planned Costs
The »Planned Costs« section contains a list of planned costs for the selection. These
costs are divided into:
• Base Costs
• Work Costs
• Attachment Costs
and the resulting Balance.
The Base Costs contain the sum of all planned base costs for the selection.
The Work Costs contain the sum of all planned work costs for the selection. The work
costs are those costs for the assigned resources.
The Attachment Costs contain the sum of all planned costs for the selection’s
attachments. The attachment costs arise from costs for attachments.
Actual Costs
The »Actual Costs« section contains a list of true costs for the selection. These costs are
divided into:
• Base Costs
• Work Costs
• Attachment Costs
and the resulting Balance.
The Base Costs contain the sum of all actual base costs for the selection.
The Work Costs contain the sum of all actual work costs for the selection. The work costs
are those costs for the assigned resources.
The Attachment Costs arise from costs for attachments.

Inspector »Assignment: Actual Values«
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In the inspector »Assignment: Actual Values« you can enter and control the project’s
actual values.



Actual values are the true values to be entered in the course of the
project.
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Actual Start
You can enter the actual start date for the selection into this field. This value corresponds
to the true starting date.

Actual End
You can enter the actual end date for the selection into this field. This value corresponds
to the true end date.

% completed
You can enter the actual completion value in percent into this field. This value corresponds
to the true completion state.

Actual Work
This section contains options for the actual work. Here you can enter and control the
values for any work to be performed. You can enter the value for the work actually
performed into the Actual Work field. Advanced options for this section are:
• Actual Overtime Work
• Remaining Work
• Reported on

Actual Overtime Work
You can enter the value for the overtime (more than planned) work actually performed into
the Actual Overtime Work field.

Remaining Work
The option Remaining Work allows you to enter the value for the remaining work to be
performed.

Reported on
The option Reported on allows you to enter a date for the entry of the actual values.

Results
This section shows the results for the actual values of the selection.
The Remaining Duration contains the value for the duration remaining in the selection.
Completed through contains the date the selection shall be completed by.

Expected
This section contains the expected values for the selection.
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• Start
• End
• Work
• Overtime Work
• Duration (consecutive)
• Utilization
The »Start« view shows the calculated value for the expected start date of the selection.
The »End« view shows the calculated value for the expected end date of the selection.
The »Work« view shows the calculated value for the expected work of the selection.
The »Duration« view shows the calculated value for the expected duration and the
expected elapsed duration (in parenthesis) of the selection.
The »Utilization« view shows the calculated value for the expected utilization of the
selection (in percent.

Planned
This section contains the currently planned values for the resource.
• Start
• End
• Work
• Duration (consecutive)
• Utilization
The »Start« view shows the value for the planned start date of the selection.
The »End« view shows the value for the planned end date of the selection.
The »Work« view shows the value for the planned amount of work for the selection.
The »Duration« view shows the value for the planned duration and the planned elapsed
duration (in parenthesis) of the selection.
The »Utilization« view contains the planned utilization value (in percent) for the
assignment.

Inspector »Assignment: User-defined«
The inspector »Assignment: User-defined« is divided into two tabs.
• Tags
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• Fields
Here you can create and control custom Tags and Fields for the assignment.

Tags

The Tags tab contains a built-in list with tags. You can expand this list using custom tags.
Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will delete the
selected existing tag. When activating the Assigned check box, the corresponding tag will
be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields
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In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »Assignment: Notes«

In the inspector »Assignment: Notes« you can enter any information as formatted text.
You can expand the content using the Gear icon and the options Insert current date or
Insert current date and time. This enables you to properly document information for later
use in this tab.
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Inspector »File«
In this inspector you can edit »File« type attachments in a project. There should be at least
one »File« type attachment present and selected in the Details view.



You can show and hide the Details view using the corresponding icon in
the icon bar.

In the work area Details view you can select the »File« type attachments added in this
project. This will open the File inspector. It contains Settings for the selected files. Merlin
Project therefore offers various options relevant for editing file attachments.
Following you will find the individual tabs in the File inspector:

Info
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The inspector »File: Info* provides options for editing information on the selected file.
Title
This is the Title or designation of the file. You can enter three titles for each file:
• Title
• Subtitle
• Additional Title
This section contains information on the attached file. The File Name field contains the file
including file name. By clicking on the Gear icon you will get further options for the file
selected in the list.
• Open
• Show
• Replace
The Open option will open the file using the appropriate application.
The Show option will display the Finder path the file is located in.
The Replace option will display a dialog to select a different file as the attachment.
Comment
This section contains further information on the selected file.
The Comment field contains custom entries on the selected file.
Below this field additional information will be displayed:
• Size
• Type
• Created
• Modified
• Name
• Comment
Size contains information on the file size.
Type contains information on the file extension.
Created shows the creation date of the file.
Modified shows when the file has been changed.
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Name shows the name of the selected file.

Inspector »File: Costs«
The inspector »File: Costs« is divided as follows.

Base costs are any further costs for a file. In the Accrual field you can enter the base cost
accrual via a drop-down menu.
Clicking on the »+« icon will create a new base cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains teh following columns for editing:
• Title
• Planned Amount
• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
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• Type
• Account
• Status
• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.

Inspector »File: User-defined«
The inspector »File: User-defined« is divided into two tabs.
• Tags
• Fields
Here you can create and control custom Tags and Fields for use with events in the project.
Tags

The Tags tab contains a built-in list with tags. You can expand this list by adding custom
tags. Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will
delete the selected existing tag. When activating the Assigned check box, the
corresponding tag will be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.
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Fields

In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »File: Notes«

In the inspector »File: Notes« you can enter any information as formatted text. You can
expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document information for later use in
this inspector.
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Inspector »Checklist«
In this inspector you can edit »Checklist« type attachments in a project. There should be
at least one »Checklist« type attachment present and selected in the Details view.



You can show and hide the Details view using the corresponding icon in
the icon bar.

In the work area Details view you can select the »Checklist« type attachments added in
this project. This will open the Checklist inspector. It contains Settings for the selected
checklist. Merlin Project therefore offers various options relevant for editing of checklist
attachments.
Following you will find the individual tabs found in the Checklist inspector:

Info

The inspector »Checklist: Info« provides options for editing information on the selected
checklist.
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Title
This is the Title or designation of the checklist. You can enter three titles for each
checklist:
• Title
• Subtitle
• Additional Title
Advanced Options
In the inspector you will also find the following options for a selected checklist:
• Creation Date
• Status
• Checklist Entries
• Notes
»Creation Date« contains the checklist’s creation date.
»Status« contains the resource’s email address. Clicking on the »@« icon will open a new
email window of the default email application. Now you can immediately send an email to
the resource.
Clicking on »+« will create a new checklist item, and clicking on »-« will delete a selected
existing item.
When creating a new item, you will be able to rename it and mark it as completed. This
affects the status value.
By clicking on the »Gear« icon you can import and export checklist items. The format used
is the OPML format.
You can enter Notes in the corresponding field for each checklist item.

Inspector »Checklist: Costs«
The inspector »Checklist: Costs« is divided as follows.
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Base costs are any further costs for a checklist. In the Accrual field you can enter the base
cost accrual via a drop-down menu.
Clicking on the »+« icon will create a new base cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains teh following columns for editing:
• Title
• Planned Amount
• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status
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• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.

Inspector »Checklist: User-defined«
The inspector »Checklist: User-defined« is divided into two tabs.
• Tags
• Fields
Here you can create and control custom Tags and Fields for use in checklists within the
project.

Tags

The Tags tab contains a built-in list with tags. You can expand this list using custom tags.
Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will delete the
selected existing tag. When activating the Assigned check box, the corresponding tag will
be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields
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In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.
Inspector »Checklist: Notes«

In the inspector »Checklist: Notes« you can enter any information as formatted text. You
can expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document information for later use in
this inspector.
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Inspector »Event«
In this inspector you can edit »Event« type attachments in a project. There should be at
least one »Event« type attachment present and selected in the Details view.



You can show and hide the Details view using the corresponding icon in
the icon bar.

In the Details view you can select the »Event« type attachments added in this project. This
will open the Event inspector. It contains Settings for the selected checklist. Merlin Project
therefore offers various options relevant for editing of event attachments.
Following you will find the individual tabs in the Event inspector:

Info

The inspector »Event: Info* provides options for editing information on the selected event.
Title
This is the Title or designation of the event. You can enter three titles for each event:
• Title
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• Subtitle
• Additional Title
Advanced Options
In the inspector you will also find the following options for a selected checklist:
• All Day
• Start
• End
• Status
• URL
• Attendee Status
• Attendees
All Day contains information on whether this is an all day event. This requires a checkbox
to be marked.
Start contains the start date of the event.
End contains the end date of the event.
Status contains options on the event status. You can edit these options in »Value List« in
the project settings.
The URL option contains a URL address relevant for this event.
The Attendee Status option contains information on the status of all attendees to the
event. This requires attendees to be added to the attendee list first.
Clicking on »+« will add an attendee to the event, and clicking on »-« will delete the
selected existing attendee from the event.
When adding a new attendee, you will be able to assign a name and a Status for his
attendance.

Inspector »Event: Costs«
The Inspector »Event: Costs« is divided as follows.
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Base costs are any further costs for an event. In the Accrual field you can enter the base
cost accrual via a drop-down menu.
Clicking on the »+« icon will create a new base cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains teh following columns for editing:
• Title
• Planned Amount
• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status
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• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.

Inspector »Event: User-defined«
The inspector »Event: User-defined« is divided into two tabs.
• Tags
• Fields
Here you can create and control custom Tags and Fields for use with events in the project.

Tags

The Tags tab contains a built-in list with tags. You can expand this list using custom tags.
Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will delete the
selected existing tag. When activating the Assigned check box, the corresponding tag will
be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields
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In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »Event: Notes«
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Inspector »Event«

In the inspector »Event: Notes« you can enter any information as formatted text. You can
expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document information for later use in
this inspector.
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Inspector »Information«
In this inspector you can edit »Information« type attachments in a project. There should
be at least one »Information« type attachment present and selected in the Details view.



You can show and hide the Details view using the corresponding icon in
the icon bar.

In the work area Details view you can select the »Information« type attachments added in
this project. This will open the Information inspector. It contains Settings for the selected
information. Merlin Project therefore offers various options relevant for editing of
information attachments.
Following you will find the individual tabs in the Information inspector:

Info

The inspector »Information: Info* provides options for editing the selected information.
Title
This is the Title or designation of the information. You can enter three titles for each
information:
• Title
• Subtitle
• Additional Title
Advanced Options
You can edit further options for information type attachments.

194

Inspector »Information«

Author allows you to define a resource as the author of the information.
»Notification date« contains the date the information was created.
Type contains a list of values for the information type. You can customize this list for
information attachments in »Project Settings > Value Lists«.
Status contains a list of values for the information status. You can customize this list for
information attachments in »Project Settings > Value Lists«.
URL contains an optional web address for the information attachment.

Inspector »Information: Costs«
The inspector »Information: Costs« is divided as follows.

Base costs are any further costs for an information.
In the Accrual field you can enter the base cost accrual via a drop-down menu.
Clicking on the »+« icon will create a new base cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains teh following columns for editing:
• Title
• Planned Amount
• Actual Amount
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The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status
• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.

Inspector »Information: User-defined«
The inspector »Information: User-defined« is divided into two tabs.
• Tags
• Fields
Here you can create and control custom Tags and Fields for use with information in the
project.
Tags
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Inspector »Information«

The Tags tab contains a built-in list with tags. You can expand this list by adding custom
tags. Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will
delete the selected existing tag. When activating the Assigned check box, the
corresponding tag will be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields
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In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »Information: Notes«

In the inspector »Information: Notes« you can enter any information as formatted text. You
can expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document information for later use in
this inspector.
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Inspector »Information«

Inspector »Issue«
In this inspector you can edit »Issue« type attachments in a project. There should be at
least one »Issue« type attachment present and selected in the Details view.



You can show and hide the Details view using the corresponding icon in
the icon bar.

In the work area’s Details view you can select the »Issue« type attachments added in this
project. This will open the Issue inspector. It contains Settings for the selected issues.
Merlin Project therefore offers various options relevant for editing issue type attachments.
Following you will find the individual tabs in the Issue inspector:

Info

The inspector »Issue: Info« provides options for editing the selected issue.
Title
This is the Title or designation of the issue. You can enter three titles for each issue:
• Title
• Subtitle
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• Additional Title
Advanced Options
There are additional options available for issue type attachments.
Reported by allows you to define a resource who reported the issue.
Assigned to allows you to define a resource who will be responsible for fixing the issue.
Supported by allows you to define a second resource for support on fixing the issue.
»Creation Date« contains the issue’s creation date.
Fix until contains the date the issue shall be fixed by.
As soon as possible can be marked in case a fastest possible fix is required.
Category contains a value list for the issue category. You can customize this list for issue
attachments in »Project Settings > Value Lists«.
Type contains a list of values for the issue type. You can customize this list for issue
attachments in »Project Settings > Value Lists«.
Status contains a list of values for the issue status. You can customize this list for issue
attachments in »Project Settings > Value Lists«.
URL contains an optional web address for the issue type attachment.

Inspector »Issue: Costs«
The inspector »Issue: Costs« is divided as follows.
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Base costs are any further costs for an issue.
In the Accrual field you can enter the base cost accrual via a drop-down menu.
Clicking on the »+« icon will create a new base cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains following columns for editing:
• Title
• Planned Amount
• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status

| Handbook for Merlin Project 4

201

• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.

Inspector »Issue: User-defined«
The inspector »Issue: User-defined« is divided into two tabs.
• Tags
• Fields
Here you can create and control custom Tags and Fields for use with issues in the project.
Tags

The Tags tab contains a built-in list with tags. You can expand this list by adding custom
tags. Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will
delete the selected existing tag. When activating the Assigned check box, the
corresponding tag will be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields
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In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »Issue: Notes«

In the inspector »Issue: Notes« you can enter any information as formatted text. You can
expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document issues for later use in this
inspector.
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Inspector »Risk«
In this inspector you can edit »Risk« type attachments in a project. There should be at
least one »Risk« type attachment present and selected in the Details view.



You can show and hide the Details view using the corresponding icon in
the icon bar.

In the work area Details view you can select the »Risk« type attachments added to this
project. This will open the Risk inspector. It contains Settings for the selected risks. Merlin
Project therefore offers various options relevant for editing risk type attachments.
Following you will find the individual tabs in the Risk inspector:

Info

The inspector »Risk: Info« provides options for editing the selected risk.
Title
This is the Title or designation of the risk. You can enter three titles for each risk:
• Title
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• Subtitle
• Additional Title
Advanced Options
You can edit the following options for risk type attachments.
Creation Date contains the risk’s creation date.
Risk Group contains a list of values for risk classification. You can customize this list for
risk type attachments in »Project Settings > Value Lists«.
The Probability option allows you to define a probability in percent for the risk to arise.
»Reported by« contains the name of the resource having reported the risk.
The In charge option contains the resource responsible for the risk.
The Risk Description option contains further notes on the risk.
Impact
This section offers options for calculating a risk status from the entered data.
The Scope option contains a list of values for the risk scope.
The Costs option contains a list of values for the risk costs.
The Deadline option contains a list of values for the impact of a risk on deadline delay.
Status
This section offers information on the risk status, calculated from the data present in the
Impact section.
The Status option contains a risk assessment.
The Probability option contains a classification of the risk probability in points.
The Scope option contains a scope classification for the risk in points.
The Costs option contains a cost assessment for the risk in points.
The Deadline option contains an assessment on the deadline impact of the risk in points.
The Total option contains the total amount of points for the risk status.
The Actions option contains further notes for the description of required actions upon the
risk arising.
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Risk Closing
Here you will be able to subsequently document information on the risk.
The Did Occur option can be marked when the risk arises.
The Closing Delay option contains the delay caused by the risk.
The Costs option contains the additional costs caused by the risk.
The Lessons Learned option contains further notes on any lessons that could be learned
by the risk having occured.

Inspector »Risk: Costs«
The inspector »Risk:Costs« is divided as follows.

Base costs are any further costs for a risk.
In the Accrual field you can enter the base cost accrual via a drop-down menu.
Clicking on the »+« icon will create a new base cost, clicking on the »-« icon will delete an
existing cost. The base costs list contains teh following columns for editing:
• Title
• Planned Amount

206

Inspector »Risk«

• Actual Amount
The Title column contains the title for the base cost position.
The Planned Amount column contains the planned sum for the base cost position.
The Actual Amount column contains the actual sum for the base cost position.
When a base cost position is selected, further options below the list become available.
These are:
• Billable
• Type
• Account
• Status
• From
Billable determines whether the costs shall be billed.
Type contains a selection of values for the type of the base cost position.
Account contains the account for the base cost position.
Status contains a selection of values for the status of the base cost position.
Added by contains the name of the resource that added the base cost position.

Inspector »Risk: User-defined«
The inspector »Risk: User-defined« is divided into two tabs.
• Tags
• Fields

The Tags tab contains a built-in list with tags. You can expand this list by adding custom
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tags. Clicking on the »+« icon will create a new tag, and clicking on the »-« icon will
delete the selected existing tag. When activating the Assigned check box, the
corresponding tag will be associated with the selection.



Custom tags assist in searching and classifying content. The relevant
column will display the tags inside the outline.

Fields

In the Fields tab you can create new fields for custom columns. These columns may
contain any freely defined values. Clicking on the »+« icon will create a new field, and
clicking on the »-« icon will delete the selected existing field.

Inspector »Risk: Notes«
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In the inspector »Risk: Notes« you can enter any information as formatted text. You can
expand the content using the Gear icon and the options Insert current date or Insert
current date and time. This enables you to properly document risks for later use in this
inspector.

| Handbook for Merlin Project 4

209

Inspector »Styles«
In this inspector you can edit styles. This inspector is particularly context sensitive. It
behaves differently depending on the current view and the selected content.
The easiest way to select a style is by right-clicking on an object in the view. The context
menu option »Style« will offer Objectives. Upon selecting an Objective the corresponding
inspector »Style« will be displayed.

The shown illustration demonstrates a secondary mouse click on a bar in the activity view.
In the »Style« context menu you will find all the options relevant for this selection.
Following we will explain the »Styles« inspector for Bars.

Bars
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The Styles inspector offers options for setting up various view options for the selection.
For
The For drop-down menu contains a variety of objectives. Here you can select the options
for a certain objective. If you want to display further objectives for the view, use a
secondary mouse click on the For drop-down menu.
Objectives included in the For context menu:
• Bars
• Labels
• Rows
• Background
• View
• Full Document
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An »Objective_ is an object that can be edited in the »Style« inspector.
Such as Bars in the Work Breakdown. You can select further correlated
objectives via For in the inspector. The available options depend on the
current selection. Clicking on the For drop-down menu while pressing
the Alt key will ist all Objectives for the object. You will get the same
result when using the Show all parts option in the drop-down menu.

You can select objectives in the »For« drop-down menu.
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Alt plus mouse click will display further objectives in the »For« menu.
Condition
You can define style options for various objectives. The Condition menu contains a list of
conditions.
Here you can add new or edit existing conditions.
The following options for conditions are available in the drop-down menu:
• In Use
• Edit
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As in the For menu, the Condition drop-down offers further conditions when clicking with
the Alt key pressed.

Select a condition from the »Condition« menu.
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Alt plus mouse click will display further conditions in the »Condition« menu.
In Use contains the condition currently used.
Edit opens a dialog for editing built-in and custom conditions.
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Clicking on the »+« icon will create a new condition, clicking on the »-« icon will delete an
existing condition. The list of conditions contains both the built-in and the custom
conditions. Clicking on the gear icon you can share custom conditions with other local
projects.

You can edit any condition by clicking on the magnifying glass icon. Here you can define
various options for the condition.
Color
In the Color section you can define color styles for the current selection. There are two
options available:
• Color
• Background Color
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The Color field defines the foreground color of the selection. By unchecking the box the
color will be reverted to the color defined in the document.
The Background Color field defines the selection’s background color.
Clicking on this field will display the Mac OS »Color« window. Here you can define a color
and save it for later use.
Height
In the Height section you can define styles for the row height. There are two options
available:
• Min. Height
• Max. Height
When unchecking the box, the values defined for the document will be applied.
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The Min. Height field contains the minimum height of rows. You can edit the height value
and the height unit here. There are three units available:
• pt
• %
• em
The Max. Height field contains the maximum height of rows. You can edit the height value
and the height unit here. There are three units available:
• pt
• %
• em
Advanced Options

The shown section contains further style options.
• Line Style
• Highlight Style
• Gradient
• Shadows
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The drop-down menus offer custom styles and – depending on the
selection – further editing options with additional styles.

Inspector »Styles«

Full Document
The Full Document style options allow you to change the appearance of the document.
The main focus is on adapting the fonts.
A secondary click on blank space in the main view allows you to select the option »Style >
Full Document« from the context menu.

In the »Style« inspector with the objective Full Document the following options are
available.
Color
The Color field allows you to select the font color. Clicking on this field will display the Mac
OS »Color« window. Here you can define a color and save it for later use.
Font
The Font field contains the font face currently set for the complete document.
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Clicking on this field will display the Mac OS »Fonts« window. Here you can change
various font options.
The Font section offers further options for editing the font. These are:
• Family
• Size
• Font Weight
• Font Style
• Font Stretch
Family contains the font family. You can change it via the drop-down menu. The available
fonts may differ depending on the fonts installed on your computer.
Size contains the font size. The font size uses the pt unit.
Font Weight defines the thickness of the font (lighter, light, regular, bold, bolder). You can
decide whether you prefer a thicker or thinner font.
Font Style defines the style (regular or italic) of the font. This enables you to set the font
style to your preference.
Font Stretch defines the font spacing (condensed, normal, expanded). This enables you to
set the font spacing to your preference.
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Inspector »Time scale«
By clicking on the time scale in the work area the following inspector will show.
In this inspector you can make adjustments to the selected time scale.

Tier
The Unit option controls the time unit for the selected time scale. Checking the control box
will fix the selected time unit.
The Date Format option lets you select a format for the dates shown in the time scale.
The Current Time Unit option will highlight the current date unit in the project view in blue
color.
Using the Time Line option you can show a red time line in the project view. The time line
will show the current time.

Date Range
For larger projects the following options are suitable to limit the visible date range.
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Start Date determines the date on which the visible date range shall begin.
End Date determines the date on which the visible date range shall end.
The Labels drop-down controls the behavior of the labels within the restricted date range.
There are the following options available:
• Extend visible range (standard)
• Cut off at edge

Non-working Time
This section offers several options for determining how to deal with non-working time.
Based on determines which calendars shall be used to define non-working times.
Darken determines how non-working times will be displayed in the project view.
Using the slider you control the appearance of regular non-working times. For example,
you can hide weekends using this option.
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Inspector »View Options«
This inspector allows you to edit the view options for the current view. This inspector is
context sensitive and contains varying options depending on the current view.
You can display the view options using various methods. E.g. via the menu »View > View
Options« or directly via the corresponding icon.

Inspector »View Options: Work Breakdown«
This inspector will show when selecting the Work Breakdown view. It contains the
following options for the work breakdown:
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Critical Path (de)activates the display of the critical path in the Gantt chart. This will also
highlight the dependencies between those activities on critical path.



The critical path is present when linked activities affect the project
deadline. Any change in a linked activity on the critical path will
automatically lead to a deadline change for the project. You can find
further information on the critical path at Wikipedia.

Dependencies (de)activates the display of links between the individual activities in the
Gantt.
The options are:
• Bar
• Time Phase
• Conflicts
• Background
• Advanced

Bar
The Bar section contains options for the appearance of bars in the Gantt.
The Labels option (de)activates the display of bar labels.
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The Secondary option (de)activates the display of planned values. These values are
displayed as gray bars and appear automatically if the actual values differ from the
planned values.
The option Group Boundaries activates/deactivates the graphical display of group
boundaries in the Gantt.



The option Group Boundaries makes groups and subgroups clearer.

Time Phase
The Time Phase section contains options for the appearance of time phases.
What is a time phase?



A time phased row shows the distribution of some content in time and its
display can be controlled by a condition. You can display the responsible
»Content Styles« inspector by right-clicking an object and then clicking
the context menu Content > Rows.
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The Labels option (de)activates the display of time phase labels.
The Description option contains settings for displaying the description (Automatic, Show
and Hide). If Automatic is set, the time phase descriptions are only shown if more than one
time phase row is enabled.
The Gradients option (de)activates the display of color gradients.
The Shadows option (de)activates the display of shadows.
Conflicts
This option lets you control whether conflicts are to be displayed in the Work Breakdown.
The Conflicts option (de)activates the display of all potential planning conflicts.
The Strong option (de)activates the display of potential strong planning conflicts.
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The Weak option (de)activates the display of potential weak planning conflicts.
Advanced
The Advanced section contains advanced view options.
The Highlight Changes option (de)activates the display of changes and the resulting
values.
The Details in secondary View option defines whether the Details view information only
relates to the current main view selection or to the entire project.
The Selection-dependent Styles option (de)activates the display of styles depending on
the selection.
The Dimming non-editable fields option (de)activates the display of calculated or noneditable fields in gray.
The Bundle adjacent lines option bundles linking lines in bar charts whenever possible.
This makes the display of dependency lines in the project more graphically appealing.
You can sort the current view according to the sorting field(s) you enter in this table. Click
on the + button to insert a new sorting field.
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Inspector »Column«
The column inspector contains two tabs. Column: Info and Column: Notes.
These tabs allow you to edit built-in and custom columns.

Inspector »Column: Info«
The Column:Info inspector contains different options for built-in and custom columns.
Built-In Columns
The Column: Info: inspector provides the following options for editing the selected built-in
column.

• Title (not editable)
• Custom Title
• Alignment
• Sorting
• Format (not for all columns)
• Column separators
The Title option for built-in columns contains the column designation and cannot be
edited.
The Custom Title option enables you to add a custom designation for built-in columns.
The Alignment option contains three alignments for column content. Column content is
generally aligned using the Align Right option. The drop down menu also contains the
Align Left and Center alignment option.
The Sorting option contains three sorting types for column content. Column content is
generally sorted using the Manual option. The drop down menu contains the additional
sorting options Ascending and Descending.
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Inspector »Column«

The Format option contains different views for column content that includes units. The
content is generally sorted using the Automatic option. This means: the column width
determines the length of the content format. The drop down menu also provides the
formats Short and Long.
Custom Columns
The Column: Info: inspector provides the following options for editing the selected custom
column.

• Title
• Alignment
• Sorting
• Type
• Summary
• Pre-defined values
• Allow free entry
The Title option for custom columns contains the column designation and is user-defined.
The Alignment option contains three alignments for column content. Column content is
generally aligned using the Align Right option. The drop down menu also contains the
Align Left and Center alignment option.
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The Sorting option contains three sorting types for column content. Column content is
generally sorted using the Manual option. The drop down menu contains the additional
sorting options Ascending and Descending.
The Type option contains various types for custom column content. The standard type for
a custom column is Text. This means that the column contains custom text. The drop
down menu provides the following types for custom column content:
• Text
• Number
• Date
• Duration
• Checkbox
• Attention Level
• Media

Type: Text

The Text option defines text for the column content. This enables you to enter any text
content into the custom column.
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The Summary option contains preferences for the calculation of values in parent levels. In
a group you can determine the values of a groups content. For text this would be the
maximum or minimum values.

Type: Number

The Number option defines the column content as a number. This enables you to enter
any number into the custom column.
The following options for number content are available in the inspector:
• Variant
• Number of decimals
• Trailing zeros
• Summary
The Variant option provides a drop down menu with the following options:
• Plain number
• Number with unit
• Percent
• Currency
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Number with unit can contain built-in units from the menu or custom units to be entered
into the field
The Number of decimals option is set to Unlimited per default. In the drop down menu you
can change the amount of decimals to be shown.
The Trailing zeros option is set to Automatic per default. For integer numbers no decimals
will be shown. The drop down menu contains the additional options Show and Don’t Show.
The values will determined by the option Number of decimals.
The Summary option contains preferences for the calculation of values in parent levels. In
a group you can add the values of a group’s content to the group or generate an average
value.

Type:Date

The Date option defines the column content as a date. This enables you to enter any date
into the custom column.
The following options for date content are available in the inspector:
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• Date Format
• Time Format
• Summary
The Date Format option contains settings for date formatting. The option Automatic will be
selected per default. It determines the date format by the column width. Further options
are »Short« and »Long«. These will always display the dates either in a short or long date
format.



You can enter dates in columns either manually or using the calendar.
Using the arrow keys up and down you can change the date in
incremental steps. Use the left and right arrow keys to navigate between
the date units.

By clicking on the calendar icon you can quickly enter dates
The Summary option contains preferences for the calculation of values in parent levels. In
a group you can add the values of a group’s content to the group or generate an average
value.

Type: Duration
The Duration option defines the column content as a duration. This enables you to enter
any duration into the custom column.
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When entering a number only, the duration in »day(s)« will be added
automatically.

The following options for duration content are available in the inspector:
• Format
• Summary
The Format option contains settings for duration formatting. The option Automatic will be
selected per default. It determines the date format by the column width. Further options
are »Short« and »Long«. These will always display the durations either in a short or long
format.
The Summary option contains preferences for the calculation of values in parent levels. In
a group you can add the values of a group’s content to the group or generate an average
value.

Type: Checkbox
The Checkbox option will display checkboxes in the respective columns. This enables you
to mark a column for any purpose.

Additional option for checkboxes:
• Summary
The Summary option contains preferences for the calculation of values in parent levels. In
a group you can add the values of a group’s content to the group or generate an average
value.
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Type: Attention Level
The Attention Level option enables you to utilize such information for columns. You can
use the Red, _Yellow and Green status along with the relevant icons.



You can add new values in the list of Pre-defined values by clicking on
the »+« icon. Remove values by clicking on the »-« icon. You can use
the following status icons with values added:

• Red rectangle
• Yellow triangle
• Green circle

Additional option for the Attention Level option:
• Summary
The Summary option contains preferences for the calculation of values in parent levels. In
a group you can add the values of a group’s content to the group or generate an average
value.
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Type: Media
The Media option will display media in the respective columns.

Additional option for media:
• Summary
The Summary option contains None and Hidden. This allows you to show or hide media in
a group.

Further Settings
The »Column: Info« inspector contains further settings which become available depending
on the selected objects.
Pre-defined values
The Pre-defined values list contains a set of pre-defined values. This list is dependent on
the selected column type. By clicking on »+« you can add custom values. Clicking on »-«
deletes the selected value.
Allow free entry
You can activate the Allow free entry option to allow pre-defined values and free text entry
in certain column configurations.

Inspector »Column: Notes«
In the Inspector »Column: Notes« you can see or enter any information describing the
column. When selected a custom field, you can expand the content using the Gear icon
and the options Insert current date or Insert current date and time. This information will
appear in the tooltip of this field when you select it in the list of available columns.
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Columns
Certain views have different columns. One example is the Outline. You can adjust the
column width using the mouse. The vertical separators assist you on this task. Click and
hold on a separator using the mouse and move the separator line.
By clicking on a column with the mouse you can move this column and change the column
order. When moving the cursor over a column, an icon will appear. When clicking on this
icon further options will show in a context menu. Double clicking on a column name will
display a list will all available columns.
The following illustration shows the standard columns used in the outline and the icon for
further column options.



When hovering over a column with your mouse, a so called tool tip with
a short description will show. These descriptions also show in the drop
down menu for the selected columns.

A secondary click on a column or a mouse click on the mentioned icon for further column
options will display a context menu.
It contains further options for sorting, editing, freezing of sort order, format and style of
the columns as well as for the use of column sets.
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You can call them from the menu, or use the Column: Info inspector. The Column: Info
inspector appears when you click a column’s header.

Add a column
To add a new column in the current view perform a secondary click on another column
header, select Add Column and select one column from the displayed list.

Custom Columns
In Merlin Project you can create custom columns. These columns may contain any content
and predefined values.
To create a custom column, click on the arrow icon in any existing column to open the
displayed context menu.
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Add a column

This will create a new column. You can edit this column in the »Column« inspector.

Column Sets
Column sets allow you to quickly switch between individual column configurations of the
current view. A secondary mouse click on an existing column will show a context menu.
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The Column Sets menu option already contains a couple of column sets delivered with
Merlin Project. Just select another Column Set to switch to this particular columns
configuration. You can edit existing column sets by adding columns and saving the set
subsequently. When clicking on Edit, the Column Sets window will appear. It contains
custom and built-in sets.
Using the »+« and »-« icons you can create or delete custom sets in the selected list.
Edited sets will be marked with a small dot. You can save these changes by clicking on the
gear symbol.



The standard column set is called Entry.

Custom Column Sets
You can save different column compositions in certain column sets for later use. A
secondary mouse click on an existing column will show a context menu.
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Custom Column Sets

When selecting the menu option Column Sets a list of existing column sets will be
displayed. Using the Edit option you can save the current column configuration as a
custom column set. To create a new custom column set, simply click on the »+« icon.



To share custom column sets with other local projects, click onto the
gear symbol and select the related option.
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Filter Function
Merlin Project’s filter function allows you to filter project content using various parameters
in order to show information according to your needs.
The filter icon is located in the top right corner above the work area. Clicking on this icon
will open the »Filter« inspector.

Creating Filters
The »Filter« inspector provides a pre-defined list of filters. Filters are divided into Custom
and Built-in filters. You can apply a filter by clicking on the open project.
Add filters by clicking on the »+« icon. You will find your own filters in the Custom section.



You can delete a custom filter by clicking on it and then clicking on the
»-« icon.

Editing Filter Conditions
You can edit any filter by clicking on the magnifying glass icon.

A pop-up window will appear. It contains various filter editing options. Available filtering
conditions depend on the selected filter.
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Filter Function

There is one condition activated for a filter per default. This is the Expected Start
condition.
Click on the illustrated drop-down menu to be able to change various conditions.

Use the drop-down menus in the filter conditions to create new filter conditions.

In the illustrated drop-down menu for the »Expected Start« you can specify the type the
condition shall be applied to.

The illustrated drop-down menu contains all options for the selection. Scroll through the
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list using your mouse.
You can add or remove conditions by clicking on the »+« and »-« icons.

Afterwards you can adjust the condition parameters.

Hierarchies
Filtering offers three view options for the project’s hierarchies. When applying the filter
you may therefore use three different view types. These are:
Show non-matching hierarchy
This view option will show the non-matching filter results. The hierarchy will remain as is
and the titles will be dimmed.

Show only matching hierarchy
This view option will list the filter results by hierarchy. This only applies when activities and
groups match all filter conditions. Non-matching results will not be shown.
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Editing Filter Conditions

Show as a flat list
This view option will list the filter results without any hierarchy. Non-matching results will
not be shown.

Enable/Disable Filters

Clicking on the Filter icon (1) will open the »Filter« inspector (2).
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When activating a filter from the list, the respective filter icon will be filled with white color
(1). This indicates an active filter. The filter name will be displayed to the right of the Filter
Icon (2), indicating that project content is filtered. When applying a filter on a project, the
filter results will be displayed in the work area (3).



Clicking on the white filter symbol will deactivate the filter and the
project content will be displayed unfiltered again.

When adding a new filter (1) the project content will be hidden until the filter (2) has been
configured. To do this, click on the magnifying glass (3).
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Keyboard shortcuts
In Merlin Project, many menu commands can be executed using keyboard shortcuts. The
following list provides you with an overview of all keyboard shortcuts used by default.



In OS X, you can adjust keyboard shortcuts for each program under
»System Preferences > Keyboard > Shortcuts«.

Table 1. Merlin Project - Shortcuts
Menu

Command

Merlin Project

About Merlin Project

Merlin Project

Preferences…

Merlin Project

Check for Updates…

Merlin Project

Hide Merlin

Merlin Project

Hide Others

Merlin Project

Quit Merlin Project

File

New

File

New From Template ▶

File

Open…

File

Combine Documents…

File

Open Recent ▶

File

Close

File

Close All

File

Save

File

Duplicate…

File

Save As…

File

Rename…

File

Move To…

File

Save As Template…

File

Revert To ▶

File

Switch User…

File

Merlin Server ▶ Documents…

File

Merlin Server ▶ Share Documents…

File

Merlin Server ▶ Setup Accounts…

File

Merlin Server ▶ Link with existing Document on Server…
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⌘,

⌘H
⌥⌘H
⌘Q
⌥⌘N

⌘O
⇧⌘M

⌘W
⌥⌘W
⌘S
⇧⌘S
⌥⇧⌘S

⇧⌘T

⇧⌘U
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Menu

Command

File

Merlin Server ▶ Unlink…

File

Integrate Changes…

File

Export…

File

Send as Email…

File

Publish ▶ Settings…

File

Publish ▶ Publish

File

Actions ▶

File

Project Settings

File

Work Area ▶ Public

File

Work Area ▶ Private

File

Work Area ▶ Private - Integrate Changes

File

Work Area ▶ Private - Publish Changes

File

Work Area ▶ Private - Discard Changes…

File

Page Setup…

File

Print…

⌘P

Edit

Undo

⌘Z

Edit

Redo

⇧⌘Z

Edit

Cut

⌘X

Edit

Copy

⌘C

Edit

Paste

⌘V

Edit

Paste…

Edit

Paste and Match Style

Edit

Delete

Edit

Select All

Edit

Copy Link

Edit

Milestone

Edit

Wirkliche Werte löschen

Edit

Find ▶ Find…

⌘F

Edit

Find ▶ Find Next (forwards)

⌘G

Edit

Find ▶ Find Previous (backwards)

Edit

Find ▶ Use Selection For Find
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⌥⌘E

⌘;

⇧⌘P

⇧⌘V
⌥⇧⌘V
⌫
⌘A

⌃⌘M

⇧⌘G
⌘E

Keyboard shortcuts

Menu

Command

Edit

Find ▶ Jump to Selection

⌘J

Edit

Find ▶ Jump to Current Date

⌘D

Edit

Find ▶ Jump to…

⌘L

Edit

Spelling and Grammar ▶ Show Spelling and Grammar

⌘:

Edit

Spelling and Grammar ▶ Check Document Now

Edit

Spelling and Grammar ▶ Check Spelling While Typing

Edit

Spelling and Grammar ▶ Check Grammar With Spelling

Edit

Spelling and Grammar ▶ Correct Spelling Automatically

Edit

Substitutions ▶ Show Substitutions

Edit

Substitutions ▶ Smart Copy/Paste

Edit

Substitutions ▶ Smart Quotes

Edit

Substitutions ▶ Smart Dashes

Edit

Substitutions ▶ Smart Links

Edit

Substitutions ▶ Data Detectors

Edit

Substitutions ▶ Text Replacement

Edit

Transformations ▶ Make Upper Case

Edit

Transformations ▶ Make Lower Case

Edit

Transformations ▶ Capitalize

Edit

Speech ▶ Start Speaking

Edit

Speech ▶ Stop Speaking

Edit

Special Characters…

Edit

Start Dictation…

Format

Show Fonts

⌘T

Format

Bold

⌘B

Format

Italic

⌘I

Format

Underline

Format

Bigger

⇧⌘+

Format

Smaller

⇧⌘-

Format

Show Colors

⇧⌘C

Format

Copy Style

⌥⌘C

Format

Paste Style

⌥⌘V
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⌥⌘T

⌘U
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Menu

Command

Insert

Activity

⌘N

Insert

Milestone

⌘N

Insert

Child

⌥⌘G

Insert

Aunt

^⌘G

Insert

Predecessor

⌥⌘P

Insert

Successor

⌥⌘S

Insert

Assignment

⌥⌘A

Insert

Attachment ▶ Checklist

Insert

Attachment ▶ Event

Insert

Attachment ▶ File

Insert

Attachment ▶ Information

Insert

Attachment ▶ Issue

Insert

Attachment ▶ Risk

Insert

Project…

Insert

Column

Structure

Indent

^⌘→

Structure

Outdent

^⌘←

Structure

Move Up

^⌘↑

Structure

Move Down

^⌘↓

Structure

Expand ▶ All

^⌘9

Structure

Expand ▶ Selection

Structure

Expand ▶ Complete Selection

Structure

Expand ▶ In Steps

Structure

Expand ▶ Assignments

Structure

Collapse ▶ All

Structure

Collapse ▶ Selection

Structure

Collapse ▶ Complete Selection

Structure

Collapse ▶ In Steps

Structure

Collapse ▶ Assignments

Structure

Link ▶ End to Start

Structure

Link ▶ End to End
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⌥⌘L

⌘9
⌥⌘9
^⌘+
⇧⌘↓
^⌘0
⌘0
⌥⌘0
^⌘⇧⌘↑
⌃⌘L

Keyboard shortcuts

Menu

Command

Structure

Link ▶ Start to Start

Structure

Link ▶ Start to End

Structure

Link ▶ Disconnect

Structure

Assignments ▶

Structure

Assignments ▶ Remove All Assignments

View

Show Tab Bar

View

Work Breakdown ▶

⌘1

View

Net Plan ▶

⌘2

View

Resources ▶

⌘3

View

Assignments ▶

⌘4

View

Report ▶

⌘5

View

Attachments ▶

⌘6

View

Filters

View

View Options

View

Details ▶ Work Breakdown ▶

⌘1

View

Details ▶ Net Plan ▶

⌘2

View

Details ▶ Resources ▶

⌘3

View

Details ▶ Assignments ▶

⌘4

View

Details ▶ Report ▶

⌘5

View

Details ▶ Attachments ▶

⌘6

View

Details ▶ View Options

View

Details ▶ On right-hand side

View

Zoom ▶ Zoom In

⌥⌘+

View

Zoom ▶ Zoom Out

⌥⌘-

View

Zoom ▶ Actual Size

⇧⌘0

View

Zoom ▶ Fit in view

⇧⌘9

View

Time scale ▶ Zoom In

⌘+

View

Time scale ▶ Zoom Out

⌘-

View

Time scale ▶ Fit Project

View

Time scale ▶ Fit Selection

View

Show Critical Path
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⌥⌘K
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Menu

Command

View

Hide Toolbar

View

Customize Toolbar…

Window

Minimize

Window

Minimize All

Window

Zoom

Window

New Window

Window

Show Previous Tab

Window

Show Next Tab

Window

Move Tab to New Window

Window

Merge All Windows

Window

Bring All to Front

Window

Enter Full Screen

Window

Window Configurations ▶

Window

Window Configurations ▶ Edit…

Window

Show/Hide Inspector

F1

Window

Show/Hide Detail View

F2

Window

Show/Hide Library

F3

Window

Show/Hide Resources Window

F4

Window

Show/Hide Warnings

F5

Window

(List of the open documents)

Help

Merlin Project Help

Help

Demo Document

Help

Merlin Project Tutorials

Help

Merlin Project on the Web

Help

Release Notes

Help

Create Support Profile…
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⌘M

^⌘F

⌘?

Keyboard shortcuts

Tips & Tricks
Here are some handy hints for using Merlin Project.

Mouse & Keyboard
You can use both the mouse and the keyboard when using Merlin Project. Many
commands can be used directly and quickly via keyboard shortcuts; other tasks are
accomplished really easily using the mouse.

Mouse
A mouse is the input device used to control the mouse pointer. In the case of portable
Macs, this may be the trackpad.



The latest Macs support a variety of input devices (mouse, trackpad,
tablet, etc.).

You can also use a number of gestures like the ones in the System Preferences in OS X.
For example, in Windows the secondary click is also known as a right-click. The mouse
and trackpad options are in the System Preferences in OS X. They include video tutorials
which explain the options.

Under "System Preferences > Trackpad", you can find the options for controlling the

| Handbook for Merlin Project 4

253

input gestures under the "Point & Click" tab.

Context Menus
In Merlin Project, you access context menus using a secondary mouse click. This provides
you with additional functions for the content you clicked.

Drag & Drop
You »Drag & Drop« content using the input device to move it.



This lets you create new groups, arrange the sequence of project
content in the outline, assign resources, and create attachments.

The procedure is always the same:
1. Make a selection
2. Drag the selection keeping the mouse button held depressed
3. Drop the selection on an object by releasing the mouse button
Example Create a group using drag & drop
You can create new groups in Merlin Project using this technique. Multiple activities can be
dragged using drag & drop and dropped onto another activity. The activity you want to
drop the content onto will be highlighted in blue and, once you release the mouse button,
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Mouse & Keyboard

assigned automatically to a group (bold) and the activities assigned to their child activities
(indented).
1. Click the selection and keep the mouse button held depressed.

2. While keeping the mouse button held depressed, move the mouse pointer to an
object (example shown here is an activity). Do not release the mouse button yet.

3. Release the mouse button to drop the selection.

Example Changing the project-structure sequence using drag & drop
In Merlin Project you can resort the sequence of activities, groups, and milestones. You
can drag multiple activities using drag & drop and drop them between other activities.
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When doing this, a blue line with a circle will appear to indicate the position between the
items of content.
1. Click the selection and keep the mouse button held depressed.

2. While keeping the mouse button held depressed, move the mouse pointer
between two objects (example shown here is »Activity 1« and »Activity 2«). Do
not release the mouse button yet.

3. Release the mouse button to drop the selection.

»Activity 3« will now be positioned between »Activity 1« and »Activity 2«.

Keyboard
Merlin Project uses a number of keyboard shortcuts.
Most commands are assigned keyboard shortcuts which appear to the right of the
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Keyboard

individual menu commands. This lets you use Merlin Project quickly and efficiently using
the keyboard. The following keys are particularly important when using keyboard shortcuts
on the Mac.

Important Keys

Keys and their descriptions:
1. Shift key (Shift) → Uppercase key
2. Control key (Control) → Equivalent to ctrl
3. Option key (Option) → Equivalent to Alt/Alt Gr
4. Command key (Command) → Equivalent to the Windows key



In the keyboard shortcut menus, the ctrl key is represented by the ^
symbol. For example, you »Enter/Exit Full Screen« from the »Window«
menu by pressing the keyboard shortcut »ctrl + cmd + F«.

The following keys are especially handy for editing content.
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5. Delete key (Backspace) → Backspace key
6. Function key (Function) → No Windows equivalent
7. Return key (Return) → Enter
8. Delete key (Delete) → DEL

Keyboard shortcuts
Keyboard shortcuts comprise multiple keys pressed simultaneously. For example, projects
can be saved by pressing [cmd + S]. "F" keys ([F1],[F2], etc.) can be accessed on all newer
Apple keyboards using the function key (fn).

Using the Mouse
• Double click a column separator and the column width will fit the content.
• Double click a column separator while keeping the alt key held depressed and
the column width will fit the content plus leave some space for control elements
(such as pop-up buttons etc.).
• Use your mouse to adjust the column separator width.
• Use your mouse to adjust the width of separators in the time scale; doing so also
alters the time scale’s zoom factor.
• Perform a secondary click (usually a right mouse click) on objects such as
activities, columns or time scales to show the context menu with options for the
clicked object.
• Cannot see the Gantt chart or bar chart in the »Activities« view? Just use your
mouse to drag the separator to the right of the work area as far to the left until
the Gantt chart or bar chart appears again.
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Another way of showing the Gantt chart or outline is by performing a
secondary click in the work area. In the context menu, select the option
Hide/Show Gantt Chart or Hide/Show Outline

• If you hover the mouse pointer over a field or element in the window, a Tool Tip
will appear after a moment telling you more about the object beneath the mouse
pointer.
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• If you close Merlin while projects are open, a notification will be displayed
automatically.

• In the main view of the Work Breakdown you can use your mouse to show/hide
the outline. All you need to do is perform a secondary click on a blank area and
select Hide Outline from the context menu. If the outline is hidden, perform a
secondary click on a blank area of the Gantt chart and select Show Outline.

• In the main view of the Work Breakdown, you can use your mouse to show/hide
the Gantt chart. All you need to do is perform a secondary click on a blank area of
the Gantt chart and select Hide Gantt Chart from the context menu. If the Gantt
chart is hidden, perform a secondary click on a blank area of the outline and
select Show Gantt Chart.
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Appendix
Acknowledgements
KissXML
Copyright (c) 2012, Robbie Hanson All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
• Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Boost Library
Boost Software License - Version 1.0 - August 17th, 2003
Permission is hereby granted, free of charge, to any person or organization obtaining a
copy of the software and accompanying documentation covered by this license (the
"Software") to use, reproduce, display, distribute, execute, and transmit the Software, and
to prepare derivative works of the Software, and to permit third-parties to whom the
Software is furnished to do so, all subject to the following:
The copyright notices in the Software and this entire statement, including the above
license grant, this restriction and the following disclaimer, must be included in all copies of
the Software, in whole or in part, and all derivative works of the Software, unless such
copies or derivative works are solely in the form of machine-executable object code
generated by a source language processor.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE
USE OR OTHER DEALINGS IN THE SOFTWARE.
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Sparkle Framework
© 2006-2013 Andy Matuschak © 2009-2013 Elgato Systems GmbH. © 2011-2014 Kornel
Lesiński © 2014 C.W. Betts © 2014 Petroules Corporation, Sparkle Project contributors ©
2014 Big Nerd Ranch All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.
EXTERNAL LICENSES
bspatch.c and bsdiff.c, from bsdiff 4.3 <http://www.daemonology.net/bsdiff/>: © 20032005 Colin Percival. SUDSAVerifier.m: © 2011 Mark Hamlin.
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted providing that the following conditions are met: . Redistributions of source code
must retain the above copyright notice, this list of conditions and the following disclaimer. .
Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
POLE - Portable C++ library to access OLE Storage Copyright © 2002-2005 Ariya Hidayat
<ariya@kde.org>

262

Acknowledgements

Performance optimization, API improvements: Dmitry Fedorov Copyright 2009-2014
<www.bioimage.ucsb.edu> <www.dimin.net>
Fix for more than 236 mbat block entries : Michel Boudinot Copyright 2010
<Michel.Boudinot@inaf.cnrs-gif.fr>
Considerable rework to allow for creation and updating of structured storage: St Copyright
2013 <srbaum@gmail.com>
Added GetAllStreams, reworked datatypes Copyright 2013 Felix Gorny from Bitplane
More datatype changes to allow for 32 and 64 bit code, some fixes involving incr
Copyright 2013 <srbaum@gmail.com>
Version: 0.5.3 Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer. - Redistributions in binary form must reproduce
the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution. - Neither the name of
the authors nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission. THIS SOFTWARE IS
PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
MiniZip Copyright (c) 1998-2010 - by Gilles Vollant - version 1.1 64 bits from Mathias
Svensson Condition of use and distribution are the same than zlib:
This software is provided 'as-is', without any express or implied warranty. In no event will
the authors be held liable for any damages arising from the use of this software.
Permission is granted to anyone to use this software for any purpose, including
commercial applications, and to alter it and redistribute it freely, subject to the following
restrictions:
1. The origin of this software must not be misrepresented; you must not claim that
you wrote the original software. If you use this software in a product, an
acknowledgment in the product documentation would be appreciated but is not
required.
2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
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3. This notice may not be removed or altered from any source distribution.
Objective-ZIP
Copyright (c) 2009-2012, Flying Dolphin Studio All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
• Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
• Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.
• Neither the name of Flying Dolphin Studio nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
LibYAML Copyright (c) 2006 Kirill Simonov <xi@resolvent.net>
Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.
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MPXJ: Microsoft Project Exchange by Jon Iles, LGPL v2 http://mpxj.sourceforge.net
libcsv - parse and write csv data Copyright © 2008 Robert Gamble
This library is free software; you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU Lesser General Public License for more details.
You should have received a copy of the GNU Lesser General Public License along with this
library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor,
Boston, MA 02110-1301 USA
libical is distributed under two licenses. You may choose the terms of either:
• The Mozilla Public License (MPL) v1.0 or
• The GNU Library General Public License (LGPL) v2.1



Software distributed under these licenses is distributed on an "AS IS"
basis, WITHOUT WARRANTY OF ANY KIND, either express or implied.
See the License for the specific language governing rights and
limitations under the License. Libical is distributed under both the LGPL
and the MPL. The MPL notice, reproduced below, covers the use of
either of the licenses.

interval_tree by Emin Martinian, LGPL v2.1
http://web.mit.edu/~emin/www.old/source_code/cpp_trees/
GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999
Copyright © 1991, 1999 Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor,
Boston, MA 02110-1301 USA Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts as the successor of the
GNU Library Public License, version 2, hence the version number 2.1.]
Preamble
The licenses for most software are designed to take away your freedom to share and
change it. By contrast, the GNU General Public Licenses are intended to guarantee your
freedom to share and change free software—to make sure the software is free for all its
users.
This license, the Lesser General Public License, applies to some specially designated
software packages—typically libraries—of the Free Software Foundation and other authors
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who decide to use it. You can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the better strategy to use in
any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use, not price. Our
General Public Licenses are designed to make sure that you have the freedom to distribute
copies of free software (and charge for this service if you wish); that you receive source
code or can get it if you want it; that you can change the software and use pieces of it in
new free programs; and that you are informed that you can do these things.
To protect your rights, we need to make restrictions that forbid distributors to deny you
these rights or to ask you to surrender these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis or for a fee, you must
give the recipients all the rights that we gave you. You must make sure that they, too,
receive or can get the source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can relink them with the library
after making changes to the library and recompiling it. And you must show them these
terms so they know their rights.
We protect your rights with a two-step method: (1) we copyright the library, and (2) we
offer you this license, which gives you legal permission to copy, distribute and/or modify
the library.
To protect each distributor, we want to make it very clear that there is no warranty for the
free library. Also, if the library is modified by someone else and passed on, the recipients
should know that what they have is not the original version, so that the original author’s
reputation will not be affected by problems that might be introduced by others.
Finally, software patents pose a constant threat to the existence of any free program. We
wish to make sure that a company cannot effectively restrict the users of a free program
by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent
license obtained for a version of the library must be consistent with the full freedom of use
specified in this license.
Most GNU software, including some libraries, is covered by the ordinary GNU General
Public License. This license, the GNU Lesser General Public License, applies to certain
designated libraries, and is quite different from the ordinary General Public License. We
use this license for certain libraries in order to permit linking those libraries into non-free
programs.
When a program is linked with a library, whether statically or using a shared library, the
combination of the two is legally speaking a combined work, a derivative of the original
library. The ordinary General Public License therefore permits such linking only if the entire
combination fits its criteria of freedom. The Lesser General Public License permits more lax
criteria for linking other code with the library.
We call this license the "Lesser" General Public License because it does Less to protect
the user’s freedom than the ordinary General Public License. It also provides other free
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software developers Less of an advantage over competing non-free programs. These
disadvantages are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain special
circumstances.
For example, on rare occasions, there may be a special need to encourage the widest
possible use of a certain library, so that it becomes a de-facto standard. To achieve this,
non-free programs must be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this case, there is little to
gain by limiting the free library to free software only, so we use the Lesser General Public
License.
In other cases, permission to use a particular library in non-free programs enables a
greater number of people to use a large body of free software. For example, permission to
use the GNU C Library in non-free programs enables many more people to use the whole
GNU operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users' freedom, it
does ensure that the user of a program that is linked with the Library has the freedom and
the wherewithal to run that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and modification follow. Pay
close attention to the difference between a "work based on the library" and a "work that
uses the library". The former contains code derived from the library, whereas the latter
must be combined with the library in order to run.
GNU LESSER GENERAL PUBLIC LICENSE - TERMS AND CONDITIONS FOR COPYING,
DISTRIBUTION AND MODIFICATION
1. This License Agreement applies to any software library or other program which
contains a notice placed by the copyright holder or other authorized party saying
it may be distributed under the terms of this Lesser General Public License (also
called "this License"). Each licensee is addressed as "you".
A "library" means a collection of software functions and/or data prepared so as to
be conveniently linked with application programs (which use some of those
functions and data) to form executables.
The "Library", below, refers to any such software library or work which has been
distributed under these terms. A "work based on the Library" means either the
Library or any derivative work under copyright law: that is to say, a work
containing the Library or a portion of it, either verbatim or with modifications
and/or translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term "modification".)
"Source code" for a work means the preferred form of the work for making
modifications to it. For a library, complete source code means all the source code
for all modules it contains, plus any associated interface definition files, plus the
scripts used to control compilation and installation of the library.
Activities other than copying, distribution and modification are not covered by
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this License; they are outside its scope. The act of running a program using the
Library is not restricted, and output from such a program is covered only if its
contents constitute a work based on the Library (independent of the use of the
Library in a tool for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.
2. You may copy and distribute verbatim copies of the Library’s complete source
code as you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to
the absence of any warranty; and distribute a copy of this License along with the
Library.
You may charge a fee for the physical act of transferring a copy, and you may at
your option offer warranty protection in exchange for a fee.
3. You may modify your copy or copies of the Library or any portion of it, thus
forming a work based on the Library, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices stating that you
changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no charge to all third
parties under the terms of this License.
d) If a facility in the modified Library refers to a function or a table of data to be
supplied by an application program that uses the facility, other than as an
argument passed when the facility is invoked, then you must make a good faith
effort to ensure that, in the event an application does not supply such function or
table, the facility still operates, and performs whatever part of its purpose remains
meaningful.
(For example, a function in a library to compute square roots has a purpose that is
entirely well-defined independent of the application. Therefore, Subsection 2d
requires that any application-supplied function or table used by this function
must be optional: if the application does not supply it, the square root function
must still compute square roots.)
These requirements apply to the modified work as a whole. If identifiable sections
of that work are not derived from the Library, and can be reasonably considered
independent and separate works in themselves, then this License, and its terms,
do not apply to those sections when you distribute them as separate works. But
when you distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of this License,
whose permissions for other licensees extend to the entire whole, and thus to
each and every part regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or contest your rights to
work written entirely by you; rather, the intent is to exercise the right to control
the distribution of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the
Library (or with a work based on the Library) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.
4. You may opt to apply the terms of the ordinary GNU General Public License
instead of this License to a given copy of the Library. To do this, you must alter all
the notices that refer to this License, so that they refer to the ordinary GNU
General Public License, version 2, instead of to this License. (If a newer version
than version 2 of the ordinary GNU General Public License has appeared, then
you can specify that version instead if you wish.) Do not make any other change
in these notices.
Once this change is made in a given copy, it is irreversible for that copy, so the
ordinary GNU General Public License applies to all subsequent copies and
derivative works made from that copy.
This option is useful when you wish to copy part of the code of the Library into a
program that is not a library.
5. You may copy and distribute the Library (or a portion or derivative of it, under
Section 2) in object code or executable form under the terms of Sections 1 and 2
above provided that you accompany it with the complete corresponding
machine-readable source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for software interchange.
If distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source code from
the same place satisfies the requirement to distribute the source code, even
though third parties are not compelled to copy the source along with the object
code.
6. A program that contains no derivative of any portion of the Library, but is
designed to work with the Library by being compiled or linked with it, is called a
"work that uses the Library". Such a work, in isolation, is not a derivative work of
the Library, and therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library creates an
executable that is a derivative of the Library (because it contains portions of the
Library), rather than a "work that uses the library". The executable is therefore
covered by this License. Section 6 states terms for distribution of such
executables.
When a "work that uses the Library" uses material from a header file that is part of
the Library, the object code for the work may be a derivative work of the Library
even though the source code is not. Whether this is true is especially significant if
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the work can be linked without the Library, or if the work is itself a library. The
threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and
accessors, and small macros and small inline functions (ten lines or less in
length), then the use of the object file is unrestricted, regardless of whether it is
legally a derivative work. (Executables containing this object code plus portions of
the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object
code for the work under the terms of Section 6. Any executables containing that
work also fall under Section 6, whether or not they are linked directly with the
Library itself.
7. As an exception to the Sections above, you may also combine or link a "work that
uses the Library" with the Library to produce a work containing portions of the
Library, and distribute that work under terms of your choice, provided that the
terms permit modification of the work for the customer’s own use and reverse
engineering for debugging such modifications.
You must give prominent notice with each copy of the work that the Library is
used in it and that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays copyright
notices, you must include the copyright notice for the Library among them, as
well as a reference directing the user to the copy of this License. Also, you must
do one of these things:
a) Accompany the work with the complete corresponding machine-readable
source code for the Library including whatever changes were used in the work
(which must be distributed under Sections 1 and 2 above); and, if the work is an
executable linked with the Library, with the complete machine-readable "work
that uses the Library", as object code and/or source code, so that the user can
modify the Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the contents of
definitions files in the Library will not necessarily be able to recompile the
application to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (1) uses at run time a copy of the library already present on
the user’s computer system, rather than copying library functions into the
executable, and (2) will operate properly with a modified version of the library, if
the user installs one, as long as the modified version is interface-compatible with
the version that the work was made with.
c) Accompany the work with a written offer, valid for at least three years, to give
the same user the materials specified in Subsection 6a, above, for a charge no
more than the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy from a designated
place, offer equivalent access to copy the above specified materials from the
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same place.
e) Verify that the user has already received a copy of these materials or that you
have already sent this user a copy.
For an executable, the required form of the "work that uses the Library" must
include any data and utility programs needed for reproducing the executable from
it. However, as a special exception, the materials to be distributed need not
include anything that is normally distributed (in either source or binary form) with
the major components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the
executable.
It may happen that this requirement contradicts the license restrictions of other
proprietary libraries that do not normally accompany the operating system. Such
a contradiction means you cannot use both them and the Library together in an
executable that you distribute.
8. You may place library facilities that are a work based on the Library side-by-side
in a single library together with other library facilities not covered by this License,
and distribute such a combined library, provided that the separate distribution of
the work based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
a) Accompany the combined library with a copy of the same work based on the
Library, uncombined with any other library facilities. This must be distributed
under the terms of the Sections above.
b) Give prominent notice with the combined library of the fact that part of it is a
work based on the Library, and explaining where to find the accompanying
uncombined form of the same work.
9. You may not copy, modify, sublicense, link with, or distribute the Library except
as expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense, link with, or distribute the Library is void, and will automatically
terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.
10. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Library or
its derivative works. These actions are prohibited by law if you do not accept this
License. Therefore, by modifying or distributing the Library (or any work based on
the Library), you indicate your acceptance of this License to do so, and all its
terms and conditions for copying, distributing or modifying the Library or works
based on it.
11. Each time you redistribute the Library (or any work based on the Library), the
recipient automatically receives a license from the original licensor to copy,
distribute, link with or modify the Library subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
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rights granted herein. You are not responsible for enforcing compliance by third
parties with this License.
12. If, as a consequence of a court judgment or allegation of patent infringement or
for any other reason (not limited to patent issues), conditions are imposed on you
(whether by court order, agreement or otherwise) that contradict the conditions
of this License, they do not excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you may not
distribute the Library at all. For example, if a patent license would not permit
royalty-free redistribution of the Library by all those who receive copies directly
or indirectly through you, then the only way you could satisfy both it and this
License would be to refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any particular
circumstance, the balance of the section is intended to apply, and the section as
a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other
property right claims or to contest validity of any such claims; this section has the
sole purpose of protecting the integrity of the free software distribution system
which is implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed through that
system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any
other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.
13. If the distribution and/or use of the Library is restricted in certain countries either
by patents or by copyrighted interfaces, the original copyright holder who places
the Library under this License may add an explicit geographical distribution
limitation excluding those countries, so that distribution is permitted only in or
among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.
14. The Free Software Foundation may publish revised and/or new versions of the
Lesser General Public License from time to time. Such new versions will be similar
in spirit to the present version, but may differ in detail to address new problems
or concerns.
Each version is given a distinguishing version number. If the Library specifies a
version number of this License which applies to it and "any later version", you
have the option of following the terms and conditions either of that version or of
any later version published by the Free Software Foundation. If the Library does
not specify a license version number, you may choose any version ever published
by the Free Software Foundation.
15. If you wish to incorporate parts of the Library into other free programs whose
distribution conditions are incompatible with these, write to the author to ask for
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permission. For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of all
derivatives of our free software and of promoting the sharing and reuse of
software generally.
NO WARRANTY
14. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.
15. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE
TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE
THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR
A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN
IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Libraries
If you develop a new library, and you want it to be of the greatest possible use to the
public, we recommend making it free software that everyone can redistribute and change.
You can do so by permitting redistribution under these terms (or, alternatively, under the
terms of the ordinary General Public License).
To apply these terms, attach the following notices to the library. It is safest to attach them
to the start of each source file to most effectively convey the exclusion of warranty; and
each file should have at least the "copyright" line and a pointer to where the full notice is
found.
<one line to give the library’s name and a brief idea of what it does.> Copyright © <year>
<name of author>
This library is free software; you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
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without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU Lesser General Public License for more details.
You should have received a copy of the GNU Lesser General Public License along with this
library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor,
Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
You should also get your employer (if you work as a programmer) or your school, if any, to
sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for
tweaking knobs) written by James Random Hacker.
<signature of Ty Coon>, 1 April 1990 Ty Coon, President of Vice
That’s all there is to it!
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